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Precautions 
Observe these precautions when installing the In-Sight 1700 wafer reader to reduce the risk 
of injury or equipment damage: 

! The In-Sight 1700 is intended to be supplied by a Listed, Direct Plug-In Power Unit 
with an output rated 24VDC, 150mA and marked Class 2, Limited Power Source 
(LPS). Any other voltage creates a risk of fire or shock and can damage the In-Sight 
hardware. 

! Do not install the In-Sight 1700 in locations that directly expose it to environmental 
hazards such as excessive heat, dust, moisture, humidity, impact, vibration, corrosive 
substances, flammable substances, or static electricity. 

! To reduce the risk of damage or malfunction due to over-voltage, line noise, 
electrostatic discharge (ESD), power surges, or other irregularities in the power 
supply, route all cables and wires away from high-voltage power sources. 

! Do not open the In-Sight 1700. This device does not contain user-serviceable parts. 
Do not make electrical or mechanical modifications to the In-Sight hardware. 
Unauthorized modifications violate your warranty. 
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1 Introduction 
In this section� 

1.1 1700 Series Overview................................................................................................1 

1.2 In-Sight Support .........................................................................................................1 

1.3 Networking a 1700 Reader ........................................................................................2 

1.1 1700 Series Overview 
The In-Sight® 1700 series of high performance vision sensors are image formation 
systems for reading identification marks on silicon wafers. Featuring a vision processor, 
advanced lighting and optics, and built-in networking support and serial communications, 
the compact 1700 readers can be utilized in virtually any back-end wafer fab process.  

The In-Sight 1700 wafer reader series includes the following models: 

! In-Sight 1700: 640 x 480 image resolution, fixed working distance 

! In-Sight 1701: 1024 x 768 image resolution, variable working distance 

The 1700 wafer reader is configured remotely over a network using a standard Internet 
browser. This browser interface also allows remote monitoring of the reader�s operation 
during runtime. The 1700 may also be controlled remotely from users� custom application 
programs using In-Sight Native Mode commands to change settings and retrieve read 
results. 

Unless otherwise specified, references to the In-Sight 1700 wafer reader in this document 
also apply to the In-Sight 1701 model. 

1.2 In-Sight Support 
The following resources are available to assist you in using the In-Sight 1700 wafer 
reader and its spreadsheet interface: 
! In-Sight Guide & Reference, an on-line HTML Help file provided on the In-Sight  

CD-ROM. 

! The In-Sight Online Support and Learning Center at 
www.cognex.com/support/In-Sight.asp. 

NOTE Only registered In-Sight users have access to the In-Sight Online Support and Learning 
Center website. 

http://www.cognex.com/support/In-Sight.asp
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1.3 Networking a 1700 Reader 
The In-Sight 1700 wafer reader is designed to operate as a host system on an Ethernet 
TCP/IP network. For the purposes of the instructions in this manual, an In-Sight network 
exists whenever one or more 1700 readers can be accessed remotely from another host 
on the network. 

The In-Sight 1700 may be used in several possible network configurations. For each 
configuration the reader is configured using an Internet browser, which also provides the 
remote display for that reader. 

1.3.1 Standalone In-Sight Network Configurations 
The most basic type of In-Sight 1700 network is shown in Figure 1-1. In this simple 
configuration, a standard CAT5 network cable and crossover coupler or a CAT5 
crossover cable directly connects a single In-Sight 1700 to a standalone PC equipped 
with a network card. Neither the PC nor the In-Sight 1700 is connected to the larger, fab 
floor network. 

 

Figure 1-1: Standalone In-Sight 1700 network 

To install multiple In-Sight 1700 readers onto a standalone In-Sight network, use an 
Ethernet switch between the In-Sight 1700s and the remote host. Make all connections 
via standard, straight-pinned CAT5 cable (Figure 1-2). 

 

Figure 1-2: Standalone In-Sight 1700 network with Ethernet switch 
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The number of 1700 readers you can install on a standalone In-Sight network is only 
limited by the number of ports available on the Ethernet switch. To expand the network, 
add Ethernet switches as needed to increase the number of available ports. 

1.3.2 Fab Floor In-Sight Network Configurations 
To take full advantage of its networking capabilities, the 1700 reader can operate as a 
host on the larger, fab floor network. The only physical difference between fab floor-
networked readers and a standalone 1700 reader network is that the Ethernet switch is 
connected directly to the network. 

Groups of 1700 readers connected to the fab floor network through a common Ethernet 
switch are referred to as a local network, or subnet. Figure 1-3 shows a subnet that 
includes several In-Sight 1700 readers and a PC host. 

 

Figure 1-3: Fab floor network 
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2 Installing the 1700 Reader 
In this section� 

2.1 Connecting the In-Sight 1700 ....................................................................................5 

2.2 Configuring the Internet Browser ...............................................................................9 

2.3 Installing In-Sight PC Host Software .......................................................................11 

2.4 Adding the 1700 to the Network ..............................................................................12 

2.5 Logging On to the 1700 ...........................................................................................15 

2.1 Connecting the In-Sight 1700 
The In-Sight 1700 has two RJ-45 connector ports: the Network port and the Breakout port 
(see Figure 2-1). The Network port provides the Ethernet connection for network 
communications. The Breakout port supplies connections for the 24VDC power source, 
I/O, acquisition trigger, and serial communications. 

 

Figure 2-1: Location of RJ-45 ports 

2.1.1 Connecting the Network Cable 

! If you are connecting to an Ethernet switch, plug one of the RJ-45 connectors of a 
CAT5 straight-pinned cable into the Network port and plug the other end into an 
available port on the switch. 

! If you are connecting directly to an In-Sight sensor from a remote host, plug 
one end of a CAT5 network cable into the crossover coupler and connect the 
crossover coupler into the 1700 reader�s Network port; plug the other end into the 
remote host�s Ethernet port. 



Section 2: Installing the 1700 Reader In-Sight® 1700 Series Wafer Reader 

6  

 
2.1.2 Connecting the Breakout Cable 
The In-Sight Breakout Cable (P/N 300-0340-15) included with every 1700 wafer reader 
provides access to the 1700 reader�s power, serial communications, and I/O lines. The 
RJ-45 connector on this cable is �keyed� to the notch in the breakout port, and cannot be 
inadvertently plugged in to the network port. 

See Section 8.2.1: Breakout Port Pin Assignments on page 90 for the Breakout Cable�s 
wiring details. 

To connect the Breakout Cable to the In-Sight 1700 reader: 

1 Verify the 24VDC power supply being used is switched off. 

2 Attach the Breakout Cable�s power (white-green wire) and ground (brown wire) to the 
corresponding terminals on the power supply. 

3 Connect the wires for the acquisition trigger, discrete outputs, and serial 
communications to their corresponding terminals on remote devices. 

4 Plug the RJ-45 connector into the 1700 reader�s breakout port (labeled 24VDC). 

5 Restore power to the 24V supply. The green power LED will indicate that the reader 
is receiving power. 

2.1.3 Connecting the Breakout Module 
The optional In-Sight Breakout Module (P/N 800-5743) is more convenient than using the 
standard Breakout Cable to connect the reader�s power, serial communications, and I/O 
lines. 

For additional information on connecting a Breakout module, see Section 8.2.1: Breakout 
Port Pin Assignments on page 90 or the Breakout Module Installation and Reference 
manual (P/N 597-0008-xx). 

 

Figure 2-2: Breakout Module Connections 
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To connect the Breakout Module to the In-Sight 1700 reader: 

1 Verify the 24VDC power supply being used is switched off. 

2 Optionally, connect the power and ground wires for the acquisition trigger input and 
the discrete outputs into their corresponding terminals on the Breakout Module. 

3 Optionally, connect the 9-pin male D-sub connector of an RS232 serial cable into the 
corresponding 9-pin female connector on the Breakout Module. 

4 Plug the Breakout Module Cable�s 15-pin male D-sub connector into the 
corresponding female connector on the Breakout Module. 

5 Plug the RJ-45 connector of the Breakout Module Cable (P/N 300-0341-15) into the 
reader�s breakout port. The cable�s connectors are �keyed� to the notch in the 
Breakout port. 

6 Plug the wire leads from a 24VDC supply for the +24V power and ground into the 
2-pin terminal plug on the Breakout Module. Alternatively, remove the terminal plug 
and insert the 2-pin terminal plug attached to the In-Sight power adapter into the 
keyed power adapter port on the Breakout Module (Figure 2-2). 

7 Restore power to the 24V supply. The red power LED on the reader and the orange 
+24V LED on the Breakout Module will indicate that the reader and Breakout Module 
are receiving power. 

2.1.4 Connecting the I/O Expansion Module 
Like the Breakout Module, the optional I/O Expansion Module (P/N 800-5758) provides 
convenient access to the In-Sight 1700 reader�s power, serial communications, and 
discrete I/O lines. But in addition to the acquisition trigger and serial transmit/receive that 
are standard on the reader, the I/O Expansion module adds the following: 

! 8 discrete outputs 

! 8 discrete inputs 

! RS232 hardware handshaking 

NOTE Firmware version 2.30 or later must be installed on the 1700 reader in order to use the 
I/O Expansion Module. 

For additional information on connecting an In-Sight I/O Expansion module, see Section 
8.2.1: Breakout Port Pin Assignments; for information on configuring the 1700 reader to 
recognize the module, see Appendix D. 
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Figure 2-3: I/O Expansion Module Connections 

To connect an I/O Expansion Module to the In-Sight 1700 reader: 

1 Verify the 24VDC power supply being used is switched off. 

2 Optionally, connect the power and ground wires for the acquisition trigger input, 
discrete outputs, and discrete inputs into their corresponding terminals on the 
Expansion Module. 

3 Optionally, connect the 9-pin male D-sub connector of an RS232 serial cable into the 
corresponding 9-pin female connector on the Expansion Module. 

4 Plug the Expansion Module Cable�s (P/N 300-0341-15) 15-pin male D-sub connector 
into the corresponding female connector on the Expansion Module. 

5 Plug the RJ-45 connector of the Expansion Module Cable into the In-Sight 1700 
reader�s breakout port. The cable�s connectors are �keyed� to the notch in the 
Breakout port. 

6 Plug wire leads from a 24VDC supply for the +24V power and ground into the 2-pin 
terminal plug labeled �Power Input� on the Expansion Module. Alternatively, remove 
the terminal plug and insert the 2-pin terminal plug attached to the (optional) In-Sight 
power adapter into the keyed power adapter port on the Expansion Module (Figure 
2-3). 

7 Restore power to the 24V supply. The red power LED on the reader and the +24V 
LED on the Expansion Module will indicate that the reader and Expansion Module 
are receiving power. 
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2.2 Configuring the Internet Browser 
The 1700 wafer reader is platform and operating system independent and can be 
controlled using a standard, Java-enabled Internet browser. A PC is not required to setup 
a wafer ID application or to monitor its runtime operation. 

When configuring the 1700 browser to communicate with the reader, there are two main 
requirements: 

! The connection must be a local area network (LAN) connection (versus dial-up). 

! The connection must not be routed through a proxy server, virtual private network 
(VPN), or similar gateway. 

The 1700 browser interface has been tested using Microsoft Internet Explorer versions 
5.0 and later on Windows XP, 2000, NT 4.0, Me, and 98SE. Using a Windows 
XP/2000/NT PC running Microsoft Internet Explorer 6 (or later) is strongly recommended. 
If using Internet Explorer 6, the Java virtual machine is not installed as part of the typical 
installation, but is installed on demand when a page using a Java Applet is first 
encountered. The latest version of Internet Explorer can be downloaded at: 
 
http://www.microsoft.com/windows/ie/default.asp. 

The Sun Java� virtual machine can also be used on a windows-based PC, and can be 
downloaded at: 
 
http://java.sun.com/getjava/index.html. 

Whichever virtual machine is being used, it must enabled for the 1700 browser interface 
to execute.  

To verify that a virtual machine is enabled: 

1 Open Internet Explorer. 

2 From the Tools menu select Internet Option� . 

3 Click the Advanced tab. 

http://www.microsoft.com/windows/ie/default.asp
http://java.sun.com/getjava/index.htmlW
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Under the Microsoft VM settings, verify that JIT compiler for virtual machine enabled is 
checked, as shown in Figure 2-4. 

or 

Under the Java (Sun) settings, verify that Use Java� is checked, as shown in Figure 
2-4. 

4 If a virtual machine was enabled, the browser must be restarted for the change to be 
applied. 

 

Figure 2-4: Internet Options Dialog � Advanced Tab 
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2.3 Installing In-Sight PC Host Software 
A Microsoft® Windows®-based PC is required to run the In-Sight PC Host program and to 
add the reader to the network. The following must be installed on the PC to load In-Sight 
PC Host Software: 

! A Microsoft Windows XP, 2000, NT 4.0 (with Service Pack 4 or later), Me, or 98SE 
operating system. 

! A network card that supports 10/100 Base-T Ethernet TCP/IP communications. 

! In-Sight PC Host software version 2.13 or later (included on the CD-ROM shipped 
with your system). 

! Internet Explorer 4.0 or higher to display the In-Sight Guide & Reference. 

NOTE Before installing the software, open the RELNOTES1700.DOC file for current information about the 
In-Sight 1700. Registered In-Sight users can obtain updated versions of the documentation at 
www.cognex.com/support/In-Sight.asp. 

To install the In-Sight PC Host program: 

1 Verify that the target PC is a recognized host on the network where the 1700 reader 
is installed. 

2 Shut down any applications running on the PC. 

3 Insert the In-Sight 1700 installation CD-ROM into the PC�s CD-ROM drive. If the 
install program starts automatically, follow the setup dialogs as they appear on 
screen. If the install program does not start automatically: 

a) Open the Windows Start menu, click Run, then click Browse. 

b) In the Browse dialog, select the PC�s CD-ROM drive, then select the 
SETUP.EXE file. 

c) Click OK to begin the In-Sight PC Host installation program. 

http://www.cognex.com/support/In-Sight.asp
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During installation, several files are copied to the PC (the default directory is 
C:\InSight2), including the following: 
 

FILE DESCRIPTION 
\IN-SIGHT.EXE The In-Sight PC Host program. 

\IS1700USER.PDF The In-Sight 1700 User Manual. Requires Adobe Acrobat Reader 4.0 or higher. 

\IN-SIGHT.CHM The In-Sight Guide & Reference, an HTML Help file containing detailed information on the In-
Sight PC Host program and remote communications. Requires Internet Explorer version 4.0 
or higher. 

\RELNOTES1700.DOC Contains last minute information concerning this release. 

\1700\IS1700.UPD 
or 
\1700\IS1701.UPD 

The firmware file for updating previously installed readers. Requires the In-Sight PC Host 
program. 

\1700\WAFID00.JAR 
\1700SYSTEM.JAR 

The Java applets providing the GUI used to configure and monitor the reader from an internet 
browser. 

\1700\INDEX.HTML 
\1700\SYSTEM.HTML 

The HTML files that load the Java applets in the internet browser. 

\1700\PROC.SET Updates system settings to load WAFID00.JOB automatically at startup. 

\1700\WAFID00.JOB The default job for the 1700, which interacts with the WAFID00.JAR applet to 
store application configuration settings on the 1700. 

4 When the installation is complete, remove the In-Sight 1700 CD from the CD-ROM 
drive. 

5 Open the program group Programs-->In-Sight2 from the Windows Start menu. Click 
on the In-Sight PC Host shortcut to run the program and verify that it installed 
correctly. The In-Sight PC Host window will appear, displaying an empty In-Sight 
spreadsheet. 

The 1700 can now be added to the network, as described in the following section. 

NOTE To complete the software installation for previously installed 1700 readers, refer to Appendix B: 
Updating the Reader for detailed instructions on updating a 1700 with new versions of the 
firmware, Java applets, HTML, and default job file. 

2.4 Adding the 1700 to the Network 
After the power and network connections to the 1700 reader have been made and the 
In-Sight PC Host program has been installed to a networked PC, the reader can be 
added as a host on the network. 

As previously described, there are many possible In-Sight network configurations. The 
specific procedure for adding an In-Sight 1700 to a network depends on whether or not a 
Dynamic Host Configuration Protocol (DHCP) server is available. The DHCP server 
automatically assigns the In-Sight 1700 sensor a network IP address and Subnet Mask. 

NOTE When installing the In-Sight reader to an existing network, consult your network administrator to 
determine whether a DHCP server is available. 
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2.4.1 Installing to a DHCP Network 
The In-Sight 1700 reader is factory-configured for installation on an existing network with 
a DHCP server. After connecting the CAT5 network cable and the Breakout, the DHCP 
server will automatically detect the reader, configure its settings, and install it on the 
network. 

After adding a 1700 reader to a network using DHCP, it is recommended that DHCP is 
disabled on the reader and that a static IP Address is assigned. 

NOTE You will need to record the IP Address to connect to the reader from an Internet browser. To find 
the IP Address that is assigned to the reader, run the In-Sight PC Host program, then open the 
System menu and select Settings!!!!. From the Settings menu, select Network. 

2.4.2 Installing to a Non-DHCP Network 
A static IP Address must be assigned to the In-Sight 1700 reader before the reader will 
be recognized on a network where a DHCP server is not available. 

To install the In-Sight 1700 reader on a non-DHCP network: 

1 Supply power to an In-Sight 1700, then open the In-Sight PC Host program. 

2 From the In-Sight spreadsheet, press <ESC> to open the System menu. 

 

Figure 2-5: PC Host System menu 
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3 Select Logon to open the Logon dialog. 

 

Figure 2-6: PC Host Logon dialog 

4 Click on the Host Name drop-down list to see the names of any In-Sight systems 
already installed on the network. 

5 Select < New > from the list to open the New Host Configuration dialog. 

 

Figure 2-7: PC Host New Host Configuration dialog 

6 Enter the last six characters of the In-Sight 1700 sensor's 12-character Media 
Access Control (MAC) address, without spaces or dashes. The first six characters 
are already entered, and should not be deleted or changed. 

NOTE The MAC address is located on a label affixed to the back of the In-Sight 1700 reader. This 
identifier is factory-assigned, unique for every In-Sight system, and cannot be changed or deleted. 

7 Verify that the Use DHCP checkbox is disabled. 

8 Enter a valid IP Address for this In-Sight reader. Every In-Sight reader must be 
assigned a unique IP Address consistent with the addressing scheme in use on the 
network. Refer to Appendix C for more information on assigning an IP Address, or 
consult your network administrator. 

9 Enter a Subnet Mask for the local network. The Subnet Mask specifies which parts 
of the In-Sight reader�s IP Address are the same for all hosts on the local network, 
and which are unique to each host. The default Subnet Mask 255.255.255.0 is 
appropriate for the vast majority of users. Refer to Section 6.2, or consult your 
network administrator for more information. 
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10 Click OK. The message box shown below appears. 

 

Figure 2-8: IP Configuration Message Box 

11 Cycle power on the In-Sight reader by removing, then reinserting, the RJ-45 
connector from the reader's Breakout port. When the reader has been located on the 
network, the following message appears: 

 

Figure 2-9: IP Configuration Completion Message Box 

If this message does not appear within one minute of cycling power, click Abort. The 
New Host Configuration dialog will reappear. Verify that the IP Address entered is valid 
and the Subnet Mask is appropriate for the local network. Make corrections as 
necessary, and repeat steps 1 through 11. Contact your network administrator if 
problems persist. 

NOTE The 1700's network settings can also be modified (i.e., disable DHCP and assign a static IP) with 
HyperTerminal through the serial port using the SetNetwork extended Native Mode command. For 
more information on the command, refer to the In-Sight Guide & Reference HTML Help file.  

This completes the basic installation procedure of an In-Sight 1700 onto a network. 
Additional, optional network settings may be configured as described in Section 6.2. 

2.5 Logging On to the 1700 
As described in the Introduction, a standard Internet browser is used to configure and 
monitor wafer ID applications on the 1700. When a connection to a reader is made from a 
browser, the Java applets resident in 1700 flash memory automatically load in the 
browser window. 

NOTE Java virtual machine (JVM) software must be installed on the host platform and supported by the 
browser used to connect to the 1700. Many browsers automatically install Java support, but this 
option may not have been enabled when your browser was installed. Refer to the documentation 
for your browser for more information. 
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To open a connection to a 1700 reader from an Internet browser: 

1 Enter the IP Address of the reader into the browser�s Address Bar (for example, 
http://192.168.0.1). An Enter Network Password dialog opens. 

 

Figure 2-10: Enter Network Password dialog 

NOTE The IP Address shown in Figure 2-10 is only an example. Every 1700 reader installed on the 
same subnet must have a unique IP Address, which must be consistent with the addressing 
scheme in use on that network. 

2 In the Enter Network Password dialog, enter the default User Name admin. 

Every 1700 reader is pre-configured with three User Names: admin, operator, and 
monitor. Each User Name is assigned a specific Access level. The Access level 
controls how much interaction is allowed for the current user to prevent inadvertent or 
unauthorized changes to the configuration. 

! Admin Level (Full): The user has complete, unrestricted access to the In-Sight 
system. Any job may be loaded, changed, and saved, and all menu selections 
are available. 

! Operator Level (Protected): The user has limited access to the In-Sight system, 
which runs only in the Custom View mode of the spreadsheet. A user in 
Protected mode can edit the values of all Graphics Controls functions visible in 
the Custom View, but cannot change the functions themselves. The System 
menu is available to toggle the In-Sight system Online/Offline, access Live mode, 
Save & Load jobs (if permitted by their FTP Read/Write privileges), and 
Customize the appearance of the interface. 

! Monitor Level (Locked): The most restrictive level of access available, a user in 
Locked mode can only monitor the operation of the current In-Sight system in 
Custom View. The System menu is disabled.  

NOTE If you are connecting to a newly installed 1700, leave the Password field blank. If you are 
connecting to previously installed 1700 you may need to enter a password. 

http://192.168.0.1/
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3 Click OK to logon to the 1700. The In-Sight 1700 Home Page will begin loading 
automatically in the browser. Wait for the page to finish loading before making any 
further selections. 

NOTE If there is no job loaded in the spreadsheet or the job is incompatible with the Java applet, an 
Invalid Job dialog appears. Click the OK button and open a compatible job. For more 
information on opening a job, see Section 4.3. 

 

Figure 2-11: Invalid Job dialog 

The 1700 is now ready to be configured using the browser interface. 
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3 Configuring a Wafer ID Application 
In this section� 

3.1 Basic Concepts ........................................................................................................19 

3.2 GUI Overview...........................................................................................................20 

3.3 Getting an Image .....................................................................................................21 

3.4 Defining Config Settings ..........................................................................................23 

3.5 Setting Options ........................................................................................................35 

3.1 Basic Concepts 
Wafer reading recipes created in In-Sight are called jobs. Each job can contain up to 10 
unique reading configurations, called Configs. Each Config specifies a type of wafer 
mark, a checksum, the string fielding, light settings, and other information. An automatic 
tuning operation can be used to optimize Config settings for maximum reading reliability. 

Jobs can run multiple Configs in a retry sequence until a successful read is achieved, or 
the mark cannot be read within the time permitted. Optionally, Configs can be tuned 
automatically during runtime if the retry sequence fails to report a successful read. 

When a Config is tried, it reports a string of characters for successful reads, or a string of 
asterisks (***) or partially read characters and question marks for failed reads. In either 
case a read score is reported. 

All of the steps necessary to configure a standard wafer ID application are performed in 
the user interface that loads automatically when you connect to a networked 1700 using 
a Java-enabled web browser, as described below. 
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3.2 GUI Overview 
The user interface that loads in the web browser when connecting to a 1700 reader is 
divided into four main areas: 

! The File tab is used to open and save job (.JOB) files. The File tab also provides 
quick File Transfer Protocol (FTP) access to files in the reader�s flash memory. 

! The Setup tab is used to select Config settings, which can then be optimized through 
the automated tuning process. 

! The Options tab is used to specify various runtime settings that determine how the 
job will execute. These settings include the source of the image acquisition/read 
trigger, the retry method to use for enabled Configs, and the data format and output 
destination of read results. The Options tab also provides a hyperlink to the System 
Settings page (see Section 6: System Settings). 

! The Run tab is the runtime view of the reader�s operation, showing the most recent 
read results and statistics for the Configs enabled in the job. The Run tab is the 
default view whenever a 1700 reader is accessed through a web browser, and is the 
only view allowed while a reader is Online. 

! Status bar. The status bar shows (from left to right) the IP Address for the 
connected reader, the Access level for the current user (Full, Protected or Locked), 
the name of the Current User, and the name of the user that is logged on with 
Admin/Operator privileges. 

NOTE Only one user at a time may log on the reader with Admin or Operator privileges. If you log on 
as Admin or Operator and another user is already logged on as Admin or Operator, that user�s 
name is shown next to Admin/Operator. When the other users logs off, the Admin/Operator 
shows �None�. Click the Refresh button to take over Admin/Operator privileges. 
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3.3 Getting an Image 
Before Config settings can be defined for reading wafer marks, a reasonable image of the 
mark is needed. 

NOTE For specific information on setting the working distance and adjusting the focus of a 1701 reader, 
see Appendix E: 1701 Wafer Reader Installation Options. 

1 In the Run tab, disable the Online checkbox. 

2 Click the Setup tab. 

3 Click the Live button. Position the wafer mark horizontally in the field of view (FOV), 
making sure that the entire mark is visible in the image. 

 

Figure 3-1: Position Mark using Live mode 
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4 When the mark is properly positioned in the image, double-click the image or click the 
Manual button to exit Live mode. 

! If the image is too bright or too dark, adjust the Light Mode and Light Power 
slider controls until the mark can be seen against the wafer background. 

! If the mark is inverted or mirrored in the image, select a different 
Image Orientation from the drop-down list. 

 

Figure 3-2: Adjusted Mark 

Repeat steps 1 through 4 as necessary. 

NOTE The lighting does not need to be optimized at this stage; the wafer mark need only be visible in the 
image. Light optimization occurs during tuning. 

When the mark is suitably imaged in the FOV, the first Config can be defined, as detailed 
in the following sections. 
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3.4 Defining Config Settings 
The Setup view contains individual tabs for each Config, numbered 0-9 (see Figure 3-3). 
Each Config contains the same default settings. These settings can be customized 
according to the type and quality of wafer marks that will be read. 

NOTE Settings can be copied between Configs. To copy settings from one Config to another, click and 
hold the left mouse button on the source Config tab then drag and drop on the tab of the target 
Config; select OK in the Copy Config dialog. When Configs are copied, the stats from the source 
Config are also copied to the target Config. 

 

Figure 3-3: Config Settings 

The following sections describe each of the settings and available selections in detail. 

3.4.1 Expand Image 
The Expand Image button allows you to increase the size of the image area. The Config 
settings are hidden while in Expanded mode. This mode is especially useful when 
properly positioning a mark in the image area. 

3.4.2 Zoom 
The Zoom drop-down list allows you to increase the magnification of the image area 
(100% to 1600%; 62% to 1600% for 1701 reader). This is especially useful when a high 
degree of precision is required in positioning graphics. 
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3.4.3 Enabled 
The Enabled checkbox determines whether the Config will be used during the retry 
sequence at runtime. The retry order for Configs is specified in the Options tab (see 
Section 3.5). When Enabled is checked, the Config number on the tab appears in bold 
text. 

NOTE All Config settings are saved with the job, even when the Config is disabled. 

3.4.4 Mark 
The Mark setting specifies the type of wafer mark the selected Config will read.  

 

SELECTION DESCRIPTION 
2D Sym, T7 Data Matrix Reads a SEMI® T7 standard 2D Data Matrix symbol (ECC 200, 8 rows by 32 columns). 
BC, BC 412 Reads a SEMI T1-95 standard barcode. (See Advanced section, below.) 
BC, IBM 412 Reads an IBM 412 barcode. (See Advanced section, below.) 
Chars, SEMI (default) Reads SEMI M12, M13, and M1.15 standard alphanumeric character strings. 
Chars, IBM Reads IBM Hexadecimal alphanumeric character strings. 
Chars, Triple Reads Triple Density standard alphanumeric character strings. 

NOTE See Appendix H: SEMI® Wafer Marking Specifications for resources providing detailed information 
on each of the SEMI mark types. 

Advanced 

When �BC, BC 412� or �BC, IBM 412� is the selected Mark, the Advanced dialog can be 
accessed from the Advanced button (see Figure 3-4). 

 

Figure 3-4: BC, Compress Advanced Dialog 

The Compression drop-down list specifies options for decoding compressed barcodes, 
including Base 35 compression, as well as a selection for decoding a barcode with no 
compression. 

When one of the Compressed options (Compressed 1 to Compressed 7) is selected, 
Report settings are also available. If Hyphen is enabled, the last two digits of the 
barcode string are separated by a hyphen. If Three Digit is enabled, the digits that are 
encoded for the wafer lot number are replaced by a three-digit number; zeros (0) are 
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used as place-holders if the lot number is less than three digits. For example, if the 
encoded lot number is �12�, the lot number would be reported as �012�. Reports settings 
are ignored if �None� is the selected Compression. 

NOTE: For specific information on the customized decoding options, please contact your Cognex Sales 
Engineer. 

3.4.5 Checksum 
The Checksum setting selects the method by which the read result from a character 
string will be validated to ensure reliability, and establishes the scoring basis for 
determining the pass/fail status of the read. 

NOTE The Checksum setting is enabled and used only when �Chars, SEMI�, or �Chars, Triple� is the 
selected Mark. When any other Mark is selected, the Checksum setting is ignored. 

In all cases, the raw read score of the character string must be higher than the specified 
Accept threshold before the checksum will be evaluated (see Section 3.4.7). Then if the 
character string passes its checksum, �bonus points� in increments of 100 and/or 200 are 
added to the raw reading score and the read passes. The number of bonus points added 
to the raw score depends on the Checksum selected. 

When Virtual Checksum is selected by itself, the Accept threshold should be increased, 
and the Field String & Field Definition should be made as specific as possible to limit the 
list of possible characters at each position in the string. These steps will increase reading 
reliability in the absence of a mathematical checksum. 
 

SELECTION DESCRIPTION 
Virtual The Cognex Virtual checksum attempts to validate the read result using multiple reading methods. 

If all methods read identical characters at each position in the string, the string passes the Virtual 
checksum and 100 �points� are added to the raw response score. 
This checksum should be used by itself only when the character string is known not to contain one 
of the other checksums, and then a higher Accept threshold is strongly recommended. 
Maximum score: 200 points 
Minimum passed score: 100 plus Accept threshold 

SEMI Applies the SEMI-standard checksum and the Cognex Virtual checksum. If the read result passes 
the SEMI checksum, 200 points are added to the raw score. If the read result also passes the 
Virtual checksum and the results from both checksums agree, an additional 100 points are added 
to the score. 
The read must pass the SEMI checksum to be successful; if Virtual checksum passes but the 
SEMI checksum fails, the entire read will fail. 
Maximum score: 400 points 
Minimum passed score: 200 plus Accept threshold 

SEMI with Virtual 
(default) 

Applies the SEMI-standard checksum and the Cognex Virtual checksum. If the read result passes 
the SEMI checksum, 200 points are added to the raw score. If the read result also passes the 
Virtual checksum and the results from both checksums agree, an additional 100 points are added 
to the score. 
The read must pass both the SEMI and Virtual checksums to be successful; if either checksum 
fails, the entire read will fail. 
The SEMI with Virtual checksum selection is the most reliable method of validating a character 
string containing a SEMI checksum. 
Maximum score: 400 points 
Minimum passed score: 300 plus Accept threshold 
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SELECTION DESCRIPTION 
BC 412 with Virtual Applies the SEMI-standard barcode checksum and the Cognex Virtual checksum. If the read result 

passes the BC 412 checksum, 200 points are added to the raw score. If the read result also 
passes the Virtual checksum and the results from both checksums agree, an additional 100 points 
are added to the score. 
The read must pass both the SEMI BC 412 and Virtual checksums to be successful; if either 
checksum fails, the entire read will fail. 
This selection is typically used when the character string is marked directly below the barcode on 
the wafer. 
Maximum score: 400 points 
Minimum passed score: 300 plus Accept threshold 

IBM 412 with Virtual Applies the IBM barcode checksum and the Cognex Virtual checksum. If the read result passes 
the IBM 412 checksum, 200 points are added to the Raw Score. If the read result also passes the 
Virtual checksum and the results from both checksums agree, an additional 100 points are added 
to the score. 
The read must pass both the IBM 412 and Virtual checksums to be successful; if either checksum 
fails, the entire read will fail. 
This selection is typically only used when the character string is marked directly below the barcode 
on the wafer. 
Maximum score: 400 points 
Minimum passed score: 300 plus Accept threshold 

3.4.6 Field String and Field Definition 
The Field String and Field Definition settings work together to define the format of the 
character string when �Chars, SEMI�, �Chars, IBM�, �Chars, Triple�, or one of the barcodes 
is the selected Mark type. 
 

NOTES 
 ■ Both The Field String and Field Definition settings are case sensitive.  

 ■ When �Chars, IBM� is the selected Mark, the only valid characters are Hexadecimal. 

 ■ When �2D Code, T7� is the selected Mark, the Field String and Field Definition settings are ignored. 

Field String 

The Field String specifies the number of characters contained in the character string or 
encoded in a barcode, including alphanumerics (A-Z, 0-9), dashes (-), dots (.), and 
spaces. 

Each character in the Field String corresponds to an indexed field position between 0 and 
21. The Field String must contain the same number of positions as there are characters 
in the wafer mark for the read to pass. By default, each position in the Field String is 
represented as an asterisk (*) character, or alphanumeric �wildcard.� This means that any 
character A-Z or 0-9 is valid at any position in the string. 

However, an individual position in the Field String can be limited to consider only a 
subset of possible characters at that position. This increases overall performance and 
reliability because characters that are not possible at a position will not be considered 
during a read. The following table lists predefined �field definitions� that can be entered in 
the Field String: 
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FIELD STRING ENTRY VALID CHARACTERS 
* = Alphanumeric wildcard ABCDEFGHIJKLMNOPQRSTUVWXYZ 

0123456789 
A = Alpha ABCDEFGHIJKLMNOPQRSTUVWXYZ 
N = Numeric 0123456789 
H = Hexadecimal 0123456789 

ABCDEF 
D = Decimal 0123456789 

dot (.) 
C = SEMI Checksum, alpha ABCDEFGH 
S = SEMI Checksum, numeric 01234567 
X = All ABCDEFGHIJKLMNOPQRSTUVWXYZ 

0123456789 
dot (.) 
dash (-) 
spaces 

dot (.) = dot (.) dot (.) 
dash (-) = dash (-) dash (-) 
space = space spaces 

NOTE All characters that are not predefined or entered in the Field Definition are treated as an 
alphanumeric wildcard. 

Example: The Field String entry for a SEMI M12 standard character string can be 
**********CS (the default Field String setting). Any alphanumeric character is valid in the 
first 10 Field String positions. But in the 11th position, only alpha characters A-H will be 
considered during the read. And in the 12th position, only numeric characters 0-7 will be 
considered. 

NOTE When the selected Mark is a barcode, the Field String must be changed so that it is appropriate for 
the selected barcode mark. 

Field Definition 

Optionally, the Field Definition setting can be used to create user-defined entries for the 
Field String if Mark specifies a character string or barcode. When included in the Field 
String, these entries restrict the list of valid characters at the positions in which they are 
inserted. 

! Multiple field definitions can be used, separated by a semicolon (;). 

! Characters listed for a Field Definition entry must be contained in the font or barcode. 
For example: &=123 is valid, because 1, 2, and 3 are valid characters. However, 
123=& is invalid because �&� is not included in the standard Semifont or barcode 
character sets. 

NOTE Using one of the predefined entries (*, A, N, H, D, C, S, X, dot, dash, space) in the Field Definition 
will remap the list of valid characters to the new definition. Therefore, it is strongly recommended 
that you do not use a predefined field definition.  

Example: If the Field Definition is &=123;$=3456;%=789, and the Field String is 
&$%*******CS, then the only characters that will be valid in the first position will be 1, 2, or 
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3. The only valid characters in the second position will be 3, 4, 5, or 6. And in the third 
position, only 7, 8, or 9 will be valid. 

3.4.7 Accept 
The Accept value specifies the minimum response threshold for the raw reading score 
(40 to 100; default = 50). The meaning of the Accept value and its role in determining the 
pass/fail status of a read depends on the type of wafer mark. 

In all cases, before a read can be considered successful, the raw score must exceed the 
Accept threshold. Only then will the bonus points for passing the checksum be added to 
the raw score, and the pass/fail status of the read determined. 

! Characters. The response score for a character string is derived from the average of 
the individual scores for all characters in the string. Refer to Section 3.4.5 for a 
detailed explanation of how the raw score combines with a checksum to determine 
the total score and pass/fail status of the read. 

NOTE It is possible for the raw score to exceed the Accept value even when individual character 
scores fall below the specified threshold. This allows character strings where all but one or 
two characters score above the threshold to be read successfully. 

! 2D symbol. The response score for a 2D symbol is the score for locating the mark in 
the image. If the 2D mark cannot be located, the score will be 0 and the read fails. If 
the 2D mark is located and the mark is decoded, 300 bonus points are added to the 
raw score (passed scoring range: 340 � 400). 

NOTE Accept is ignored when �2D Sym, T7 Data Matrix� is the selected Mark type. 

! Barcode. The response score for a barcode is the percentage of �scan lines� within 
the Region that correctly detect the length of the string encoded in the barcode. If at 
least three scan lines decode the same string that passes the checksum, 300 bonus 
points are added to the raw score 
(passed scoring range: 310 � 400). 

NOTE Accept is ignored when a barcode is the selected Mark type. 

3.4.8 Image Orientation 
The Image Orientation setting selects the orientation of the wafer mark in the image. The 
default orientation is Normal. 

SELECTION DESCRIPTION 
Normal (default) Unmodified image acquired by the reader. 
Mirrored horizontally Horizontally mirrors the acquired image. 
Flipped vertically Vertically flips the acquired image. 
Rotated 180 degrees Rotates the acquired image by 180 degrees. 
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3.4.9 Light Mode and Light Power 
Each Config can have unique Light Mode and Light Power settings for optimizing the 
readability of the wafer mark in the image. In-Sight will automatically determine the 
optimal light settings for a mark during the tuning process if both the Bright Field and 
Dark Field checkboxes in the Tune dialog are enabled. 

Light Mode 

The Light Mode setting specifies either a Bright Field or a Dark Field illumination effect on 
the mark. Each position on the Light Mode slider control enables specific groups of LEDs 
to achieve the intended effect in the image. 
 

SELECTION DESCRIPTION 
Slider position 0 All lights are disabled. Use this mode only when an external light source is required in a 

specialized application. 
Slider positions 1-3 
(BF1�BF3) 

The mark will appear dark on a light background. 
Default = BF1 

Slider positions 4-12 
(DF1�DF8) 

The mark will appear light on a dark background. 

Light Power 

The Light Power setting controls the effective intensity of the LEDs on the mark by 
increasing the exposure time of the 1700�s CCD imager, in increments of 0.167 
milliseconds. Decrease Light Power for a darker image; increase it for a lighter image. 
Generally, use Light Power to maximize the contrast of the mark relative to the 
background on the wafer. 

NOTE The effect of the Light Power setting is visible in the duration of the �strobed� light pulse as the 
reader acquires an image. 

3.4.10 Character Spacing 
When �Chars, SEMI�, �Chars, IBM� or �Chars, Triple� is the selected Mark, the Character 
Spacing setting controls the tolerance of the spacing between adjacent characters and 
the vertical alignment of the characters. For more information on SEMI Wafer Marking 
Specifications, see Appendix H. 

NOTE The current Character Spacing setting is used during tuning (Section 3.4.15),  

SELECTION DESCRIPTION 
Standard Spacing Reads the characters using standard SEMI specifications for character spacing and vertical 

character alignment. 
Relaxed Spacing Reads the characters with more tolerance for deviations from the specifications for character 

spacing and alignment. 
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3.4.11 Retry 
The Retry drop-down list specifies the tuning behavior of the Config during the retry 
sequence at runtime. The retry order for Configs is specified in the Options tab (see 
Section 3.5). 

SELECTION DESCRIPTION 
Disable (default) The Config will be tried, but not fine tuned*; fine tuning differs from the more exhaustive tuning 

process during setup (see Section 3.4.15). 
Enable The Config will be tried, and fine tuned. 
Enable & Apply The Config will be tried and can be fine tuned. If tuned successfully the new settings will be 

applied to the Config, overwriting the previous settings. 

*Fine tuning adjusts the Light Power by ± .5 ms, in increments of .2 ms. It also adjusts the Size region ± 1 pixel, both high and wide. 
This continues on all enabled Configs until the there is either a read or the timeout is exhausted. 

NOTES 
 ■ Enabled must be checked for a Config to be included in the retry sequence, regardless of the Retry 

selection. 

 ■ The Retry setting is ignored when the In-Sight protocol TUNE(<Config>) command is issued. 

3.4.12 Color 
The Color setting is optional in most Configs, for use when the optimal Light Mode for a 
particular type of wafer mark is already known, or when the Bright Field and Dark Field 
checkboxes will be disabled during tuning. 

By default In-Sight will automatically determine the correct color of the mark as imaged 
during the tuning process if both the Bright Field and Dark Field checkboxes in the Tune 
dialog are enabled. 
 

SELECTION DESCRIPTION 
Auto (default) Automatically selects �White� or �Black� depending on the current Light Mode setting.  
Black Specifies a black mark on a light background. Use when Light Mode is set to Bright Field. 
White Specifies a light mark on a dark background. Use when Light Mode is set to Dark Field. 

NOTE The Color setting is ignored when the selected Mark is a barcode. 

3.4.13 Region 
The Region defines the area in which the wafer mark is expected to appear in the FOV. 
The mark must be sufficiently illuminated and entirely contained within the Region or the 
read will fail. Generally, the mark may be rotated as much as ± 5 degrees within the 
region without a significant decrease in readability. 

NOTE When '2D Sym, T7 Data Matrix' is the selected Mark, the Region must be set no larger than 120 
pixels high. If the Region height is set larger than 120 pixels, the read will fail. 
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To set the Region: 

1 Click the Edit Region button. The image area will expand, and the interactive region 
box will appear (Figure 3-5). 

 

Figure 3-5: Editing the Region 

2 Adjust the region as necessary to encompass the entire mark. The image 
coordinates and the size of the region (row, column, height, width) are displayed 
below the box. 

! To move the region, position the  cursor anywhere inside the box, then click 
and hold the left mouse button while dragging. 

! To resize the region, position the cursor over an edge or corner of the region, 
then click and hold the left mouse button while dragging. 

TIP To move the region one pixel at a time, use the arrow keys on the keyboard; to resize the 
region one pixel at a time, use shift-arrow keys. 

To finish editing the region and accept the changes, double left-click anywhere in the 
image, or click the Save button above the image area. 
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3.4.14 Size 
Size defines the expected height and width of a 2D symbol or the characters in a string, 
as measured in pixels. 

NOTES 
 ■ When a BC 412 or IBM 412 barcode is the selected Mark type, Size is disabled. 

 ■ The Zoom function can be especially useful when positioning the Size region. 

To set the mark size: 

1 Click the Edit Size button. The image will automatically expand. 

2 To adjust the Size, position the  cursor inside the size box, then click and hold the 
left mouse button while dragging. To resize the box, position the cursor over an edge 
or corner of the box, then click and hold the left mouse button while dragging. 

TIP To move the size box one pixel at a time, use the arrow keys on the keyboard; to resize box 
one pixel at a time, use shift-arrow keys. 

! If �Chars, SEMI�, �Chars, IBM� or �Chars, Triple� is the selected Mark, Size defines 
the height and width expected for each character in the string. To set the size for 
characters, position the Size box around a character so that its edges align with 
the centers of the strokes, as shown in Figure 3-6. �Square� characters with 
horizontal and vertical strokes � such as 0, 3, and Φ � are the best to use when 
setting the size, though any character can be used. 

 

Figure 3-6: Editing Character Size 

! If �2D, Sym T7 Data Matrix� is the selected Mark, Size defines the height and 
width expected for the entire 2D symbol. To set the size for 2D symbols, position 
the Size box so that it aligns with the centers of the corner cells of the matrix, as 
shown in Figure 3-7.  

 

Figure 3-7: Editing 2D Data Matrix Size (Shown at 200% Zoom) 

To finish editing the box and accept the changes, double left-click anywhere in the image, 
or click the Save Size button. 
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3.4.15 Tune 
The Tune button accesses the automated tuning process used to optimize Config 
settings (see Figure 3-8). 

During tuning, an exhaustive read test is performed on the mark using many 
combinations of Light Mode, Light Power, Size, and Color settings (and the current 
definitions for the Mark, Checksum, Accept, Field String/Definition, Character Spacing 
and Region settings). After each iteration, the string and score results for the last read 
are displayed. The best string and score result achieved so far are shown, along with 
counts of the total number of reads attempted and the number of successful reads. 

NOTE The image display is not updated during tuning. 

 

Figure 3-8: Tuning a Character String 

When tuning is completed, the combination of settings that correctly read the mark with 
highest score is retained, and can be applied to the Config or discarded. 
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To tune a Config: 

Choose the tune options to try by enabling/disabling the checkboxes. By default, Bright 
Field, Dark Field, and Size are enabled. Disabling a checkbox causes tuning to use the 
current definition for the corresponding setting in the Config. 

! Light Power is automatically tuned if one or both Light Mode options (Bright Field 
and Dark Field) are enabled. If both Light Mode options are disabled, the current 
Config settings for Light Mode and Light Power will be used, and lighting will not 
be tuned. 

! When the Size option is enabled, tuning will try sizes ± 10 pixels from the current 
Size setting in the Config. 

! Color tuning always occurs. The correct color will automatically be selected in the 
Config if the tune settings are accepted. 

During tuning: 

! Click Pause to pause tuning. Click Continue to resume tuning from where it left 
off. 

! Click Accept to stop tuning and update the Config with the settings of the best 
read so far (the Accept button will be grayed out until the first passed read). 

! Click Reset to stop tuning and discard the tuning results. 

! Click Back to stop tuning, discard the tuning results, and return to the Config 
settings. 

After tuning is completed: 

! Click Accept to apply the tuned settings to the Config. 

! Click Reset to re-initialize all tuned settings. Select a different combination of 
tuning options, then click the Start button to tune again. 

! Click Back to return to the Config settings. The Config will be updated with the 
tuned results if Accept was clicked previously. Otherwise, the tuned settings will 
be discarded. 

TUNING TROUBLESHOOTING TIPS 
 ■ Make sure the Field String contains the correct number of characters, and any dots, dashes, and 

spaces are in the correct positions. 

 ■ Make sure the correct Checksum is selected (for Chars). 

 ■ Make sure Region and Size settings are reasonable before tuning. 
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3.4.16 Read 
The Read button, below the Config settings, acquires an image and performs a �test� 
read on the wafer mark using the current Config. The String and Score results are 
reported to the right. If the read passes, the String appears on a green background; failed 
reads appear on a red background. 

3.5 Setting Options 
The selections in the Options tab (Figure 3-9) control how the configured wafer ID 
application will operate during runtime. 

 

Figure 3-9: Options Tab 

3.5.1 Read 
Read options control the try sequence for enabled Configs. Optionally, image acquisition 
can be disabled to allow test reads from image files when the reader is offline. 

Read Timeout & Read Order 

Read Timeout specifies the total amount of time (up to 60 seconds) to allow for a read, 
including retries and tuning of enabled Configs. When the timeout limit is reached without 
a successful read, the read fails. 

NOTE Specifying a Read Timeout differs from terminating the execution of the read using the Abort 
Execution command. For more information on this command, , refer to Section 7: Native Mode 
Commands. 



Section 3: Configuring a Wafer ID Application In-Sight® 1700 Series Wafer Reader 

36  

Read Order Specifies the order in which enabled Configs will be tried until a successful 
read is obtained. 
 

SELECTION DESCRIPTION 

Last Best 
(default) 

Configs will be tried in the order they scored (from highest to lowest) during the last read until a 
passed score is read. 

In Order Configs will be tried in numerical order (0-9), regardless of how they scored during the most recent 
read. 

Disable Acquire 

Disables image acquisition to allow a test read from the last image acquired, or from an 
image file, when the reader is offline. The Light Mode and Light Power settings are 
disabled, as are the Acquire and Live buttons. 

To read from an image file: 

1 Check the Disable Acquire checkbox. 

2 Load a valid .BMP or .JPG image file (640 x 480, 8-bit) using one the following 
methods: 

! With the In-Sight PC Host open, drag and drop an image file onto the 
spreadsheet. Or, open the Save & Load dialog (System#Save & Load) and 
select an image from a different In-Sight host on the network. 

! Open an FTP connection to the reader (for instructions see Appendix B: 
Updating the Reader). Drag and drop the image file into the FTP window of the 
web browser, or use the mput command from an FTP prompt. 

NOTE You do not need to rename the image file before loading it on the 1700. The reader will 
automatically copy the .BMP or .JPG file to the built-in file names, IMAGE.BMP or 
IMAGE.JPG, respectively. 

3 Click the Read button on either the Setup or Run tab to read from the image file. 

4 Repeat step 2 to read from a different image file, or uncheck Disable Acquire in the 
Options tab to return the reader to normal operation. 
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Show Output Graphics 

When the Show Output Graphics checkbox is enabled, the character�s score, the read 
character, and the center coordinate of the character are displayed. If the mark passes, 
the output graphics are shown in green; if the score is below the Accept value, the output 
graphics are shown in red. If a character cannot be read, a question mark is displayed. If 
the mark fails, and the character�s score is above the Accept value, the output graphics 
for the character are shown in green. An example with Output graphics enabled is shown 
in Figure 3-10. 

NOTE Output Graphics are only shown when the selected Mark is �Chars, SEMI�, �Chars, IBM�, or �Chars, 
Triple�. 

 

Figure 3-10: Output Graphics 

3.5.2 Input/Output 
Input/Output options control how reads are initiated on the 1700 reader, and the data 
format of the output results. 

Trigger 

Selects the source of the trigger that acquires an image and initiates a read. 
 

SELECTION DESCRIPTION 
Camera Reads when the acquisition input on the reader receives a pulse from an external trigger source. 
Network 
(default) 

Reads when the READ command is received from a remote network host through a TCP/IP 
device connection at the specified Port. 

Serial Reads when a READ command is received from a remote RS232 serial device. 

NOTE When �Serial� is the selected Trigger, the Mode setting in the Serial tab on the System Settings 
page must be �Text�. 
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Output Destination 

Determines where results are sent after each read. 
 

SELECTION DESCRIPTION 
Network Sends read results to a remote network host through a TCP/IP device connection at the specified 

Port. 
Serial Sends read results to a remote RS232 serial device. 

NOTE When �Serial� is the selected Output Destination, the Mode setting in the Serial tab on the System 
Settings page must be �Text�. 

Protocol 

Determines the command that a remote device sends to initiate tuning and reading, and 
the format for outputting the results data. 

NOTE The reader must be Online. 

COMMANDS 
SELECTION 

Read Tune* 

In-Sight READ(<Config>) 
READ 

TUNE(<Config>) 

EG ESC-y1wXON** n/a 

* Each time the TUNE command is sent, the Light Power is adjusted by ± .5 ms, in increments of .2 ms, and the Size region is 
adjusted ± 1 pixel, both high and wide. 

** �ESC� and �XON� are control characters. 

In-Sight Protocol 

In-Sight is the default protocol for the 1700 reader. This protocol can be used with either 
a TCP/IP or RS232 connection. If used with TCP/IP, a valid Port number must be 
specified. When using an RS232 serial device, the settings in the Serial tab (see Section 
6.4 Configuring Serial Port Settings) should be configured as follows: 

! Baud Rate = 1200 

! Data Bits = 8 

! Stop Bits = 1 

! Parity = None 

! Handshake = Xon/Xoff 

! Mode = Text 

NOTE If using the Send Message Native Mode command, the selected Mode must be Native. For more 
information on the Send Message command, refer to Section 7: Native Mode Commands. 
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Also, the Text Mode settings in the Text Mode Details dialog (shown in Figure 3-11) 
should be configured as follows:  

! Fixed Input Length = 6 

! Input Terminator = 13 

! Output Terminator = 13 

 

Figure 3-11: Text Mode Details Dialog 

 

When using the In-Sight protocol, a Read can either be done on a single Config using the 
READ(<Config>) command, or on all enabled Configs using the READ command; this 
command uses the Read Order selected in the Options tab (see Section 3.5.1 Read). 
Also, if ��1� is used for the Config number to be read, the command is the same as using 
the READ command. Tuning is done on a single Config using the TUNE(<Config>) 
command. If the READ command needs to be terminated before the Read Timeout (see 
Section 3.5.1) is exhausted, the Abort Execution Native Mode command can terminate 
the READ execution. For more information on the Abort Execution command, refer to 
Section 7: Native Mode Commands. 

When In-Sight is the selected Protocol, the Output String will be a character string for a 
successful read. For a failed read, the output will either be a partial read (where 
unreadable characters are displayed as question marks) or a string of asterisks. The type 
of output is dependent on the Score (see Section 5.1.6: Score). 
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An example of the outputs using the In-Sight protocol commands from Microsoft 
Windows' built-in Telnet client are shown in Figure 3-12. 

 

Figure 3-12: In-Sight Protocol Output Example 

EG (Electroglas) Protocol 

Protocol (TCP/IP or RS232) for use with an Electroglas, Inc. wafer prober. If used with 
TCP/IP, a valid Port number must be specified. When using an RS232 serial device, the 
settings in the Serial tab (see Section 6.4 Configuring Serial Port Settings) should be 
configured as follows:  

! Baud Rate = 1200 

! Data Bits = 8 

! Stop Bits = 1 

! Parity = None 

! Handshake = Xon/Xoff 

! Mode = Text 

Also, the Text Mode settings in the Text Mode Details dialog (shown in Figure 3-11) 
should be configured as follows:  

! Fixed Input Length = 6 

! Input Terminator = 13 

! Output Terminator = 13 

When using the EG protocol, a Read can only be done on all enabled Configs using the 
READ(-1) command. This command also uses the Read Order selected in the Options 
tab. 

When EG is the selected Protocol, the Output String will be either a character string for a 
successful read or a string of asterisks for a failed read. When using the EG Protocol, 
partial reads are not returned, since any return other than a strings of asterisks will be 
interpreted by the wafer prober as a successful read. The number of asterisks returned 
will be the same as the number of characters specified in the Field String (see Section 
3.4.6: Field String and Field Definition). 
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An example of the outputs using the EG protocol commands from Microsoft Windows' 
built-in Telnet client are shown in Figure 3-13. The first Read command (entered as a 
sequence of ASCII characters) shows the output for a successful read; the second Read 
command shows the output for a failed read. 

 

Figure 3-13: EG Protocol Output Example 

Port 

Assigns the TCP/IP port number to use when �Network� is selected in the Trigger or 
Output Destination settings. This port number is where a TCP/IP connection is 
established between the 1700 reader (a TCP/IP server waiting for communication) and a 
remote device (a TCP/IP client that initiates communication). The default port is 2000, but 
any unused number between 1 and 65535 may be used, excluding 21, 23, 68, 1069 and 
1070 (reserved by the 1700 reader).  

Output String, Output Score, Output Passed 

These checkboxes select the results data that will be sent to the Output Destination after 
a read. By default, only the Output String box is checked. When the Output Passed 
checkbox is enabled, the resulting data is either a �1.000� if the read passes or �0.000� if 
the read fails. 

3.5.3 Logging 
Read results may be written to a log file saved on a network host. Logging options 
specify which results are written to the log file. 

Host Name 

The name of the remote host on the network where the log file will be created. 

File Name 

The name of the file on the specified host where log entries will be appended. The log file 
is an HTML document; the .HTM extension is automatically appended to the File Name. 
This file is saved in the default FTP directory; subdirectories cannot be specified. The 
maximum File Name length is 64 characters. 

User 

A valid User name for the specified host. 
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Password 

A valid password for the User on the specified host. 

Output String, Output Score, Output Passed, Output Failed Image 

These checkboxes select the results data that will be written out to the HTML file on 
specified network Host. Data is appended to the specified log file. The log file must be 
reset manually by deleting, renaming or moving the current InSight.htm file, or by 
specifying a new file name for the log file. The reader must be Online for data to be 
appended to the log file. An example of the HTML log page, with all outputs selected, is 
shown below. 

 

Figure 3-14: HTML Log Page Example 
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4 Managing Job Files 
In this section� 

4.1 About Job Files ........................................................................................................43 

4.2 Saving Jobs .............................................................................................................44 

4.3 Opening Jobs...........................................................................................................44 

4.4 Sharing Jobs Between Readers ..............................................................................44 

4.5 Changing the Startup Job ........................................................................................45 

4.1 About Job Files 
The File tab (Figure 4-1) provides access to Job files stored in flash RAM on the 1700 
reader. 

 

Figure 4-1: File Tab 

To use the browser interface, at least one job file must be stored on the reader. The job 
file can be the default job, WAFID00.JOB, or any other compatible job that has been 
saved using the browser interface. The File tab also lists the job currently being used by 
the applet; this job cannot be deleted. 

NOTE Jobs that have been modified directly in the In-Sight PC Host spreadsheet can be used, but only if 
the predefined functions and formulas in the spreadsheet cells have not been rearranged, deleted, 
or otherwise changed in such a way as to break compatibility with the WAFID00.JAR Java applet. 
See Appendix A for more information about the default job, WAFID00.JOB.  
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4.2 Saving Jobs 
Jobs must be saved on the 1700 to preserve changes made to Config and Options 
settings. If the job is not saved, all settings changes will be lost when a new job is opened 
or the power is cycled on the 1700. 

To save a new job: 

1 Click on the File tab. 

2 Click the Save As.� button. 

3 Enter a new file name (do not include a directory or subdirectory) in the Save 
As�dialog. Job file names can contain up to 15 characters (the .JOB extension will 
be added automatically).  

4 Click OK to save the Current Job to a new job file, or Cancel. 

To save changes to an existing job: 

1 Click on the File tab. 

2 Click the Save button. 

3 Click OK to save the Current Job, or Cancel. 

4.3 Opening Jobs 
Only job files stored in the reader�s flash memory can be opened using the browser 
interface. 

To load an existing job from 1700 memory: 

1 Click on the File tab. 

2 Save changes made to the Current Job, if needed. 

3 Highlight a job file in the list. 

4 Click the Open button. 

5 Click OK in the Open File dialog to load the job, or Cancel. 

4.4 Sharing Jobs Between Readers 
A job file saved on one 1700 reader may be shared with other readers on the network 
using FTP to copy the file. 
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4.5 Changing the Startup Job 
By default, the 1700 reader is configured to load the WAFID00.JOB automatically after 
receiving power. However, after making changes to Config and Options settings and 
saving to a different job file, you will want to configure the reader to automatically load 
and run that new job at startup. 

To change the default startup job for the reader: 

1 Click on the Options tab. 

2 Click on the System link in the upper-right to access the reader�s System Settings. 

3 Click the Startup tab. 

4 Select a new job file to load on startup from the Job list. 

5 Click the Save button. 
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5 Running the Job 
In this section� 

5.1 The Run tab .............................................................................................................47 

5.1 The Run tab 
The Run tab is the only view of the 1700 reader available from the browser interface 
during runtime operation. 

 

Figure 5-1: Run Tab 
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The following sections describe the information displayed in the Run tab.  

5.1.1 Online Checkbox 
The Online checkbox at the top-right of the Run tab switches the reader between its 
Online and offline modes of operation. When this checkbox is enabled (the default 
setting), the reader is �online�. The File, Setup, and Options tabs are grayed out, and the 
following operations are supported: 

! Output read results data to the log file specified in the Options tab. 

! Output read results over the serial port when Serial is the selected Output 
Destination in the Options tab. 

! Respond to the protocol�s READ and TUNE commands. 

! Respond to the camera, network, and serial acquisition Trigger selected in the 
Options tab. 

! Send/receive data to and from the spreadsheet over the network or serial port 
using the Input/Output functions. 

NOTE If the Online checkbox is enabled from the browser and a System Offline dialog appears, open the 
PC Host and verify that the PC Host�s status bar indicates the reader is online, then click OK to 
close the dialog. 

When the Online checkbox is disabled, the reader is �offline�, and the operations listed 
above are not possible. However, the following actions are allowed: 

! Edit settings in the Setup and Options tabs. 

! Save & open jobs in the File tab. 

! Manually acquire an image and read the wafer mark using the Read button. 

! Clear all read results using the Reset Stats button. 

! Execute Native Mode commands over telnet. 

The reader�s Online state is a combination of three independent flags: 

! Spreadsheet flag � Set directly from the System menu�s Online checkbox in the 
In-Sight spreadsheet. This flag can also be controlled by the Online checkbox in 
the Startup tab (see Section 6.6). For the browser-based user interface to run 
properly, this flag should be enabled. 

! Native Mode flag � Set from the Online checkbox in the Run tab or from the Set 
Online Native Mode command (see Section 7.1.3). 

! Discrete I/O flag � Not used by the reader; enabled by default. 

The reader is Online only when all three flags are enabled. 
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5.1.2 Read Log 
A record of the most recent read results. This log returns the string, score, and pass/fail 
status of each Config that is read or retried. 

NOTE If the reader is offline, a continuous log is displayed. If the reader is online, only the last read 
results are displayed.  

5.1.3 Statistics Window 
A statistical record of the read results. 

NOTE Any changes to a Config�s settings will reset the statistics for that Config, but do not change the 
overall statistics. 

Config 

The index of each enabled Config. 

Attempts 

The number of times that the Config has been used during reading. 

Passed 

The number of times that the Config read successfully. 

Failed 

The number of times that the Config failed to read. 

Response Avg 

The average raw response score of all attempted reads for the Config. 

Overall 

The cumulative statistics from the results of all reads. 

NOTE The Overall statistics are calculated independently of the statistics for the individual Configs.  

5.1.4 Read 
The Read button acquires an image and reads the wafer mark. The String and Score 
results are reported to the right. The Read button is grayed out when the Online 
checkbox in enabled. 
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5.1.5 String 
The character string result for the last read. If the read passes, the string appears on a 
green background. 

Failed reads appear on a red background. If a failed read�s score is above the minimum 
threshold for reporting results, individual string characters are displayed. Any character in 
the string that cannot be read is displayed as a question mark. If the failed score is below 
the minimum threshold, all characters are shown as asterisks. The number of asterisks 
returned will be the same as the number of characters specified in the Field String (see 
Section 3.4.6:Field String and Field Definition). 

5.1.6 Score 
The score for the last read. For more information on scoring, see Sections 3.4.5 and 
3.4.7. 

5.1.7 Reset Stats 
The Reset Stats buttons clears all results in both the Read Log and Statistics windows. 
The Reset Stats button is grayed out when the Online checkbox in enabled. 
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6 System Settings 
In this section� 

6.1 About System Settings ............................................................................................51 

6.2 Version Information..................................................................................................52 

6.3 Configuring Network Settings ..................................................................................52 

6.4 Configuring Serial Port Settings...............................................................................56 

6.5 Managing the User List ............................................................................................58 

6.6 Startup Options ........................................................................................................58 

6.1 About System Settings 
Each 1700 has its own system settings that control the reader�s networking configuration 
and serial port settings, the list of authorized users, and the startup behavior. These 
settings are stored in the reader�s PROC.SET file, and apply to all jobs. 

To access a reader�s System Settings from the browser interface: 

1 Click on the Options tab. 

2 In the Options tab, click on the System hyperlink in the upper-right corner. 

NOTE System Settings may also be configured using the In-Sight PC Host. 
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6.2 Version Information 
The Info tab shows important information about your 1700 reader and its current 
firmware and applet version. This information is needed if assistance is ever required 
from Cognex Technical Support. The Online checkbox at the top-right of the Run tab 
switches the reader between its online and offline modes of operation. For more 
information about the Online checkbox, see Section 5.1.1. The Back hyperlink, located 
below the Online checkbox, returns you to the Run tab. 

 

Figure 6-1: Info Tab 

6.3 Configuring Network Settings 
The Network tab (Figure 6-2) configures an In-Sight system to be used on a network. 

 

Figure 6-2: Network Tab 

Use DHCP Server 

The Use DHCP Server checkbox determines whether the 1700 reader uses DHCP 
(Dynamic Host Configuration Protocol) on start up or if the values in the Network Settings 
dialog configure TCP/IP. 

NOTE This box should be checked only if a DHCP server is running on the local network. If the box is 
checked and a DHCP server does not respond within 60 seconds, the reader will boot without 
network support enabled. 
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All of the settings that can be configured in the Network tab depend on whether this 
checkbox is enabled. If enabled, the checkbox allows the 1700 reader to be configured 
automatically by a DHCP server at startup. Optionally, a new Host Name may be 
assigned, but all other fields in the Network tab will be grayed out.  

However, if the Use DHCP Server checkbox is disabled, the network settings 
for the 1700 must be configured manually. If the reader was previously assigned an 
IP Address using DHCP, disabling the Use DHCP Server checkbox will use the same IP 
Address. 

In production environments, a static IP Address should be used instead of DHCP. Using 
a static IP Address removes the need for a DHCP server on the local network and 
eliminates extraneous DHCP traffic. 

IP Address 

Assigns a unique identifier for each reader on the network, which must be consistent with 
the IP address-numbering scheme of the local network. 

NOTE The IP Address setting is grayed out when the Use DHCP Server checkbox is enabled. 

Unlike the factory-set MAC address, the IP address is assigned automatically by a DHCP 
server or must be manually assigned by the user. The following IP addressing schemes 
are recommended: 
 

ADDRESSING SCHEME DESCRIPTION 
10.0.0.0/8 The 10.0.0.0/8 private network is a class A network ID that allows valid IP addresses from 10.0.0.1 

to 10.255.255.254. The 10.0.0.0/8 private network has 24 host bits which can be used for any 
subnetting scheme within the private organization. The default Subnet Mask is 255.0.0.0. 

172.16.0.0/12 The 172.16.0.0/12 private network can be interpreted either as a block of 16 class B network IDs 
or as a 20-bit assignable address space (20 host bits) which can be used for any subnetting 
scheme within the private organization. The 172.16.0.0/12 private network allows valid IP 
addresses from 172.16.0.1 to 172.31.255.254. The default Subnet Mask is 255.255.240.0. 

192.168.0.0/16 The 192.168.0.0/16 private network can be interpreted either as a block of 256 class C network 
IDs or as a 16-bit assignable address space (16 host bits), which can be used for any subnetting 
scheme within the private organization. The 192.168.0.0/16 private network allows valid IP 
addresses from 192.168.0.1 to 192.168.255.254. The default Subnet Mask is 255.255.0.0 

Subnet Mask 

Defines which part of the reader�s IP address refers to the network and which part refers 
to the host. 

NOTE When DHCP is enabled, this field is grayed out and displays the value assigned by DHCP. 
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The network part of the IP address is the same for all hosts on the same subnet, and the 
remainder is unique to each host. As shown in the table below, a Subnet Mask of 
255.255.255.0 (a class C mask) identifies 24 bits for the network portion and 8 bits for the 
host portion. Most users will not need to change the default Subnet Mask setting of 
255.255.255.0. 
 

CLASS SUBNET MASK NETWORK ADDRESS HOST ADDRESS 
A 255.0.0.0 8 bit 24 bit 
B 255.255.0.0 16 bit 16 bit 
C 255.255.255.0 24 bit 8 bit 

Default Gateway 

Specifies the IP address of the gateway host, if available on the network. 

NOTE The Default Gateway setting will be grayed out when the Use DHCP Server checkbox is enabled. 
The value shown is the gateway assigned by the DHCP server. 

The gateway host is responsible for sending and receiving data between hosts on 
different networks, routing data packets from a device on the local subnet to a device on 
another subnet. 

For example, if a 1700 reader will need to communicate with a remote host on a different 
subnet, enter the address of the gateway device in the Default Gateway field. However, if 
the reader will need to communicate only with devices on the local subnet, do not enter 
an address for the Default Gateway (leave the field all zeros). 

DNS Server 

Specifies the IP address of the host on the network providing DNS resolution, if available. 

NOTE The DNS Server setting will be grayed out when the Use DHCP Server checkbox is enabled. The 
value shown is the DNS Server assigned by the DHCP server. 

A Domain name (i.e., yourcorp.com) is an alias for an IP address (i.e., 192.168.0.1). A 
DNS (Domain Name Server) maintains the data on corresponding domain names and IP 
addresses. The DNS Server setting determines which host is contacted (by IP address) 
in response to a given Domain Name. 

Host Name 

Assigns a name, or �alias� for the reader as it will appear when browsing the network 
using the In-Sight PC Host.  

Each 1700 reader has its host name set automatically the first time it boots. The format is 
�is17xxxxxx", where �xxxxxx" consists of the last 24 bits of the reader�s unique MAC 
address. For example, a reader with the MAC address 00-d0-24-00-06-0b will be 
assigned the host name, "is1700060b". 

NOTE The Host Name setting is not automatically assigned by the DHCP server (if used) or referenced 
through the DNS server. If the Use DHCP Server checkbox is enabled and the DHCP server 
supplies the Host Name, it is ignored in favor of the default host name or the name entered by the 
user. 
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Domain 

Specifies the 1700 reader�s Fully Qualified Domain Name (FQDN) for the network on 
which it is installed. 

NOTE When the Use DHCP Server check box is enabled, this field is grayed out and displays the value 
assigned by the DHCP server. 

An In-Sight 1700 must have a FQDN to be accessible from a remote host that is not part 
of the local network. The Domain setting sets the string that is appended to the host 
name to make a FQDN. 

For example, setting Domain to yourcorp.com yields the following results: 

! If a host name is is1700060b, the FQDN for lookup is 
is1700060b.yourcorp.com. 

! If a host name is is1700060b.yourcorp.com. (notice the period at the end), the 
FQDN for lookup is is1700060b.yourcorp.com. 

Appending the period to the end of the host name prevents redundancy in appending the 
Domain name to the FQDN. For example, if the period is omitted, is1700060b. 
yourcorp.com would become is1700060b.yourcorp.com.yourcorp.com). 

FTP Settings 

This button opens the FTP Settings dialog to configure the File Transfer Protocol (FTP). 
FTP Settings dialog controls include: 

! Idle Timeout: The amount of time (in seconds) that a connection from another 
host may be left open without any activity. The default is 120 seconds. 

! Read Timeout: The amount of time (in seconds) that FTP remains blocked in a 
read (or write). This value is used to recover from an unresponsive peer. The 
default is 120 seconds. 

! Connection Retry: The number of times to try connecting to a peer. The default 
is 1 try. 

! Local Port: The port address at which the local FTP server awaits connections. 
The default port is 21. 

! Remote Port: The port address at which a remote FTP awaits connections. The 
default port is 21. 

! Passive Transfers: This checkbox enables "passive" FTP client transfers, which 
may be required when In-Sight needs to access an FTP server through a firewall 
that does not allow connections to be initiated from the outside. The checkbox is 
OFF by default. 
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Host Table 

This button opens the Host Table dialog to specify a local mapping of network host 
names to IP addresses. Host Table dialog controls include: 

! Favor Host Table over DNS: When enabled, this checkbox specifies that the 
search order for In-Sight host names will be the host table, followed by the 
network browser, then DNS. When disabled, the Host Name search order is the 
network browser, followed by the host table, and then DNS. 

! Host Name: The name of the networked In-Sight system to map (or assign) to 
the specified IP Address. The Host Name entered will appear in any list of Host 
Names throughout the In-Sight interface. 

! IP Address: The IP Address of the networked In-Sight system to map to the 
specified Host Name. 

6.4 Configuring Serial Port Settings 
The Serial tab (Figure 6-3) configures the 1700 reader�s RS232 serial port 
communications.  

 

Figure 6-3: Serial Tab 

Baud Rate 

300, 600, 1200, 2400, 4800, 9600, 14400, 19200, 38400, 57600, or 115200 (default). 

Data Bits 

7 or 8 (default). 

Stop Bits 

1 (default) or 2. 

Parity 

None (default), Even, or Odd. 
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Handshake 

None, Xon/Xoff, or Hardware (default). 

Mode 

Sets the serial protocol to use. 

SELECTION DESCRIPTION 
Text Standard ASCII protocol for sending/receiving text strings. To define the input and output 

terminator characters, press the Details button to open the Text Mode Details dialog. �Text� must 
be the selected Mode when Trigger and Output Destination are set to �Serial�. 

Native (default) Custom ASCII protocol for controlling In-Sight from any remote host. To define the input and 
output terminator characters, press the Details button to open the Native Mode Details dialog. 

DeviceNet Protocol for communicating with Allen-Bradley PLC (requires an optional, RS232-to-DeviceNet 
Gateway adapter from Cognex). To define the input and output data packets sizes, press the 
Details button to open the DeviceNet Details dialog. 

Motoman Protocol for communicating with Motoman MRC, MRC-II, and XRC robot controllers operating in 
DCI mode. 

Unused Closes the serial port so that no commands or data can be received/sent. 

Details 

Opens the Details dialog for the selected Mode. 

SELECTION DESCRIPTION 
Text Mode Details The Text Mode Details dialog defines the terminator characters to use for Text Mode serial 

communications. Text Mode Details dialog controls include: 

! Fixed Input Length: Reads a fixed number of characters before triggering an event. 

! Input Terminator: The ASCII value interpreted by In-Sight as the end of an incoming string. 
The default is 13 (carriage return). 

! Output Terminator: The ASCII value that In-Sight adds to each output string to mark the end 
of the transmitted string. The default is 13 (carriage return), and 0 specifies "no terminator". 

Native Mode Details The Native Mode Details dialog defines the terminator characters to use for Native Mode serial 
communications. Native Mode Details dialog controls include: 

! Fixed Input Length: Reads a fixed number of characters before triggering an event. 

! Input Terminator: The ASCII value interpreted by In-Sight as the end of an incoming string. 
The default is 13 (carriage return), and 0 specifies "no terminator". 

! Output Terminator: The ASCII value that In-Sight adds to each output string to mark the end 
of the transmitted string. The default is 13 (carriage return), and 0 specifies "no terminator". 

DeviceNet Mode Details The DeviceNet Mode Details dialog defines the terminator characters to use for The DeviceNet Mode 
serial communications. DeviceNet Mode Details dialog controls include: 

! Input Packet Size: Sets the expected packet size to be received through the DeviceNet 
Interface Module, in bytes. The setting must agree with the MaxWidth value in the RS232-to-
DeviceNet configuration. 

! Output Packet Size: Sets the packet size to send out through DeviceNet Interface Module, in 
bytes. The setting must agree with the Transmit Width value in the RS232-to-DeviceNet 
configuration. 

! Trigger on First Byte: Triggers an acquisition when the first byte is received. 
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6.5 Managing the User List 
The User List tab (Figure 6-4) administers the access level and FTP read/write privileges 
for authorized users of a 1700 reader. The User List settings determine which users may 
log onto a particular reader using any of the available methods: browser interface 
(HTTP), In-Sight PC Host, Telnet, and FTP. The User List also specifies the types of 
configuration changes they can make. The User List is specific to each reader and is not 
shared between readers; if a user needs access to a particular reader, they must know a 
User Name and password that already exists in that reader�s User List. 

 

Figure 6-4: User List Tab 

6.6 Startup Options 
The Startup tab (Figure 6-5) specifies job-related startup options for a 1700 reader, 
including the default job and Online/Offline status. 

As described previously in Section 4.1, a reader must have a job file loaded that is 
compatible with the default job, WAFID00.JOB. 

 

Figure 6-5: Startup tab 
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7 Native Mode Commands 
In this section� 

7.1 Native Mode Commands .........................................................................................61 

7.2 Put Extended Native Mode Commands ..................................................................64 

7.3 Inputs and Outputs ..................................................................................................66 

7.4 Evaluate Extended Native Mode Commands (Actions) ..........................................69 

7.5 Evaluate Extended Native Mode Commands (Get).................................................72 

7.6 Evaluate Extended Native Mode Commands (Set) .................................................80 

The In-Sight 1700 reader supports many Native Mode commands that allow the reader to 
be controlled from users� custom application programs over Ethernet or serial port. 

NOTE When logging on to an In-Sight system through Telnet from a Unix-based platform, the In-Sight 
system�s host name (or IP Address) and port number (usually 23) must be added to the command 
line. For example: >telnet is170060b 23. Supplying the port number disables the Unix 
username/password authentication and forces the Unix system to prompt you for User Name and 
password. 

Below is a partial listing of the Native Mode commands typically used to control the 1700 
remotely. 

NATIVE MODE COMMANDS 
Abort Execution Terminates the current execution of the WafID function within the spreadsheet.  
Send Message Sends an ASCII string to an In-Sight spreadsheet over a Native Mode connection, and 

optionally, triggers a spreadsheet Event. 
Set Online Sets the In-Sight system into Online or Offline mode. 

 

PUT EXTENDED NATIVE MODE COMMANDS 
Put live Turns live acquisition on/off. 
Put portnum Specifies the network port used by In-Sight to transfer data and live images. 
Put watch Returns the data contained in the specified cell when the cell is updated. 

 
EVALUATE EXTENDED NATIVE MODE COMMANDS (ACTIONS) 

EV AcquireConfig Acquires an image using a Config�s light settings, but does not read. 
EV ReadConfig Reads using the specified Config. 
EV TuneConfig Tunes a specific Config and optionally, saves the optimized settings. 
EV ResetStats Reset all accumulated read statistics. 

 



Section 7: Native Mode Commands In-Sight® 1700 Series Wafer Reader 

60  

EVALUATE EXTENDED NATIVE MODE COMMANDS (GET AND SET) 

EV GetConfig Settings information for the specified Config. 
EV GetConfigAccept 
EV SetConfigAccept 

The threshold Accept setting for a Config. 

EV GetConfigAvgScore The average raw response score of all reads that passed for a Config. 
EV GetConfigCharHigh 
EV GetConfigCharWide 
EV SetConfigCharSize 

The settings information for the Size setting. 

EV GetConfigChecksum 
EV SetConfigChecksum 

The index of the Checksum selection for a Config. 

EV GetConfigColor 
EV SetConfigColor 

The index of the Color selection for a Config. 

EV GetConfigEnable 
EV SetConfigEnable 

The status of the Enabled checkbox for a Config. 

EV GetConfigFieldDef 
EV SetConfigFieldDef 

The contents of the Field Definition setting for a Config. 

EV GetConfigFieldString 
EV SetConfigFieldString 

The contents of the Field String setting for a Config. 

EV GetConfigHigh 
EV GetConfigWide 

The Size settings for a Config. 

EV GetConfigLightMode 
EV SetConfigLightMode 

The index of the Light Mode selection for a Config. 

EV GetConfigLightPower 
EV SetConfigLightPower 

The Light Power selection for a Config. 

EV GetConfigMark 
EV SetConfigMark 

The index of the Mark selection for a Config. 

EV GetConfigNumFailed The number of failed reads for a Config. 
EV GetConfigNumPassed The number of passed reads for a Config. 
EV GetConfigNumTuneFailed The number of failed reads during a tune for a Config. 
EV GetConfigNumTunePassed The number of passed reads during a tune for a Config. 
EV GetConfigOrcChar The ASCII value of the indexed character in a read string. 
EV GetConfigOrcCol The column coordinate of the indexed character in a read string. 
EV GetConfigOrcRow The row coordinate of the indexed character in a read string. 
EV GetConfigOrcVal The raw response score of the indexed character in a read string. 
EV GetConfigOrientation The index of the Img Orientation setting for the specified Config. 
EV GetConfigPassed The pass/fail status of the specified Config for the most recent read. 
EV GetConfigRegionRow 
EV GetConfigRegionCol 
EV GetConfigRegionHigh 
EV GetConfigRegionWide 
EV SetConfigRegion 

The settings information for the Region setting. 

EV GetConfigResult The results of the most recent read performed by the specified Config. 
EV GetConfigRetry 
EV SetConfigRetry 

The index of the Retry setting for the specified Config. 

EV GetConfigScore The score for a Config during the most recent read. 
EV GetConfigString The character results for a Config during the most recent read. 
EV GetConfigStringLen The number of characters contained in the result string. 
EV GetConfigTheta The orientation of the mark for a Config. 
EV GetConfigTryLog The Retry status of the Config during the last read. 
EV GetConfigTuneLog The Retry and Tune status of the Config during the last read. 
EV GetMSBuffer The Machine Status data stored in one of 8 indexed buffers within the MachineStatus 

stack. If the index is 0, the current Machine Status is returned. 
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EVALUATE EXTENDED NATIVE MODE COMMANDS (GET AND SET) 

EV GetWaferAcqEnable 
EV SetWaferAcqEnable 

The status of the Disable Acquire setting. 

EV GetWaferAll  All results for the most recent read, and settings for all Configs. 
EV GetWaferAvgScore The average raw response scores for all Configs that passed. 
EV GetWaferBestConfig The index of the Config that passed during the last read. 
EV GetWaferFixCol The column coordinate of the fixture. 
EV GetWaferFixRow The row coordinate of the fixture. 
EV GetWaferFixTheta The orientation of the fixture. 
EV GetWaferNumFailed The number of failed reads for all Configs. 
EV GetWaferNumPassed The number of passed reads for all Configs. 
EV GetWaferOrder 
EV SetWaferOrder 

The index of the Read Order setting. 

EV GetWaferSummary A summary of the results for the most recent read. 
EV GetWaferTimeout 
EV SetWaferTimeout 

The total amount of time (in seconds) to allow for a read. 

For more information on these commands, refer to the In-Sight Guide & Reference HTML 
Help file, included in the installation package. 

7.1 Native Mode Commands 
The following Native Mode commands are used to remotely control an In-Sight 1700 from 
user-designed software. Each command returns a Status Code, the number of characters 
(in bytes, including Carriage Returns and Line Feeds) in the output that follows, and the 
results. 

7.1.1 Abort Execution 
AE[2] 

Terminates the current execution of the WafID function within the spreadsheet. Unlike 
most Native Mode commands, no status code is returned after the Abort Execution 
command is executed, but depending on the function that is terminated, other information 
may be returned. 

Input: 2 

Sample Input and Output 

NOTE In this sample, Abort Execution causes the current read operation to terminate. 

AE2 
 
SM"READ"0 
1 
AE2 
[UH587IX1CGC3,390.000,1.000] 
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7.1.2 Send Message 
SM"string"[Event] 

Allows In-Sight protocol commands (see Section 3.5.2: Input/Output) to be sent over a 
Native Mode connection to a 1700 reader as a text string, and optionally, triggers a 
spreadsheet Event. 

Inputs: String, Event (Optional). 

The Event codes are: 

EVENT CODE DESCRIPTION 
(0 to 7) Specifies a soft trigger (Soft 0, Soft 1, ... Soft 7). 
8 Acquire an image and update the spreadsheet. This option requires the AcquireImage 

function�s Trigger argument to be External or Manual. 

NOTE The string must be set off with quotations marks.  

Output: Status Code, Read Result. 

The status codes are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-2 The command could not be executed. 

NOTE The outputs for the read result depend on which of the Output String, Output Score, and Output 
Passed checkboxes are selected from the Options tab (see Section 3.5: Setting Options) 

Sample Inputs and Outputs 
SM"READ"0 
 
1 
[UH587IX1CGC3,398.000,1.000] 
 

SM"TUNE(0)"0 
 
1 

[UH587IX1CGC3,391.000,1.000] 
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7.1.3 Set Online 
SO[int]  

Sets the In-Sight system into Online or Offline mode. 

NOTE: This command cannot set the In-Sight system Online if it was previously set Offline manually 
through the user interface, or by a discrete input signal. 

Inputs: 0 to set In-Sight Offline, and 1 to set In-Sight Online. 

Output: Status Code. 

The status codes are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-1 The value given for int is either out of range, or is not a valid integer. 
-5 The communications flag was successful but the system did not go Online because the 

system is set Offline manually through the user interface or the Discrete I/O setting is off. 

Sample Input and Output 
SO 1 
 
1 
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7.2 Put Extended Native Mode Commands 
The following commands are used in conjunction with the Put extended Native Mode 
command to send information to the In-Sight spreadsheet and system. The information 
sent is dependent on the command that is specified. 

7.2.1 Put Live 
Put Live(<Input>) 

Turns live acquisition on/off. 

NOTES 
 ■ The system must be offline when using this command.  

 ■ The live image will not be displayed in the GUI or PC Host. 

Inputs: 0 to turn off live acquisition mode, and 1 to turn on live acquisition mode. 

Output: Status Code, # of bytes 

The status codes are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-1 The input is invalid. 
-2 The command could not be executed, or the system is online. 

Sample Input and Output 

NOTE In this sample, the first command puts the system into live acquisition mode, and the second 
command takes the system out of live mode. 

PUT LIVE 1 
 
1 
 

PUT LIVE 0 
 
1 
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7.2.2 Put PortNum 
Put PortNum(<Input>) 

Specifies the port that will be used by the In-Sight system for transferring data or images 
over the network. 

NOTES 
 ■ The system must be offline when using the Portnum command.  

 ■ The PortNum command must be executed before another device can connect to the specified port. 

Inputs: 0 to 65535 to specify the port number. 

NOTE A valid Port assignment is any unused number between 0 and 65535, except for reserved ports. 

Output: Status Code 

The status codes are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-1 The port number is invalid. 
-2 The command could not be executed, the system is online, or the specified port is already in 

use. 

Sample Input and Output 
PUT PORTNUM 3001 
 
1 
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7.2.3 Put Watch  
Put Watch(<Column><Row><Input>) 

Returns the data contained in the specified cell each time the cell is updated. 

NOTE The PortNum command must be executed to specify a port where the information will be sent by 
the Watch command. 

Inputs: Column, Row, Input 

Output: Status Code 

The status codes are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-2 The command could not be executed. 

Sample Input and Output 
PUT WATCH A000 1 
 
1 
 

7.3 Inputs and Outputs 
The table below list the possible values of the settings that can be input and possible 
values of the settings and results data returned by the Evaluate Native Mode commands. 
These output values are enclosed in Extensible Markup Language (XML) tags (XML is a 
web document authoring language which allows users to create their own customized 
tags. For more information on the XML format, go to http://www.w3.org/XML). 

SETTING DESCRIPTION 
<Accept> The minimum response threshold for the raw reading score. 

40 � 100 (default = 50) 
<AcqEnable> The status of the Disable Acquire setting. 

0 = Disable 
1 = Enable 

<AcquireFlag> Determines whether an image will be acquired when a read is performed.  
0 = A read will be performed on the last image acquired. 
1 = A read will be performed after a new image is acquired. 

<AvgScore> The average raw response score of all reads that passed for a Config. 
0 � 100 

<BestConfig> The index of the Config which returns the highest score. 
0 � 9 

<Bright> Determines whether Bright Field Light Mode settings will be tried during tuning.  
0 = Disable Bright Field tuning 
1 = Enable Bright Field tuning 
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SETTING DESCRIPTION 
<Char> The ASCII value of the specified character in a read string. 
<CharSize> The settings information for the Size setting. 

High: 16 � 120 (default = 42) 
Wide: 8 � 480 (default = 20) 

<CheckSum> The method by which the read result from a character string will be validated to ensure 
reliability, and establishes the scoring basis for determining the pass/fail status of the 
read. 
0 = Virtual 
1 = SEMI 
2 = SEMI with Virtual (default) 
3 = BC 412 with Virtual 
4 = IBM 412 with Virtual 

<Col> The column coordinate of the input region or the individual character in a string. 
4 � 640 

<Color> The expected color of the mark to read. 
0 = Black 
1 = White 
2 = Auto (default) 

<Config> The Config number (0-9). 
<Dark> Determines whether Dark Field Light Mode settings will be tried during tuning. 

0 = Disable Dark Field tuning 
1 = Enable Dark Field tuning 

<Enable> The status of the Enabled setting for the specified Config. 
0 = Disable 
1 = Enable 

<FieldDef> Specifies user-defined entries for the Field String. 
User-defined 

<FieldString> The number of characters contained in the character string or encoded in a barcode. 
alphanumerics (A-Z, 0-9), dashes (-), dots (.), spaces, and entries from FieldDef. 

<Fixture> The coordinates and orientation of the fixture. 
Col:  4 � 640 
Row: 4 � 480 
Theta: 0 � 359 

<Flag> Specifies whether tuning will be performed on a Config.  
0 = Start tuning 
1 = Continue tuning 
2 = Accept current parameters 

<High> (CharSize) The height of a 2D symbol or the average height of the characters in a string, as 
measured in pixels. 
16 � 120 (default = 30) 

<High> (Region) The height of the region (along the Y-axis) in which the wafer mark is expected to appear 
in the field of view. 
4 � 180 (default = 100) 

<Char Index> Specifies the position number (zero-based) of a character within a string. 
<LightMode> Determines either a Bright Field or a Dark Field illumination effect on the mark. 

0 = All lights are disabled 
1 � 3 = The mark will appear dark on a light background 
4 � 11 = The mark will appear light on a dark background 

<LightPower> The exposure time of the 1700�s CCD imager, in milliseconds.  
0.000-33.000 (default = 2.000) 

<Mark> The type of wafer mark the selected Config will read.  
0 = 2D Sym, T7 Data Matrix 
1 = BC, BC 412 
2 = BC, IBM 412 
3 = BC, IBM 412 (Base 35)  
4 = Chars, SEMI 
5 = Chars, IBM 
6 = Chars, Triple 
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SETTING DESCRIPTION 
<NumFailed> The number of failed reads for a Config.  

0 � 99,999 
<NumPassed> The number of passed reads for a Config.  

0 � 99,999 
<NumTuneFailed> The number of failed reads during a tune for a Config.  

0 � 99,999 
<NumTunePassed> The number of passed reads during a tune for a Config.  

0 � 99,999 
<Order> The order in which enabled Configs will be tried until a successful read can be obtained. 

0 = Last Best (default)  
1 = In Order (0-9) 

<Orientation> The index of the Img Orientation setting for the specified Config. 
0 = Normal 
1 = Mirrored horizontally 
2 = Flipped vertically 
3 = Rotated 180 degrees 

<Passed> The pass/fail status of the specified Config for the most recent read. 
0 � 99,999 

<ReadLog> A record of the most recent read that passed. 
0-9 

<Region> The region where the wafer mark is expected to appear in the field of view. 
Row and High: 4 � 480 
Col and Wide: 4 � 640 

<Retry> The tuning behavior.  
0 = Disable (default) 
1 = Enable 
2 = Enable & Apply 

<Row> The row coordinate of the input region or the individual character in a string. 
4 � 480 

<Score> The average raw response scores for all Configs that passed. 
0 � 400 

<Size> Specifies whether the mark size will be modified during tuning.  
0 = Disable Size tuning 
1 = Enable Size tuning 

<String> The character results from the read. 
alphanumerics (A-Z, 0-9), dashes (-), dots (.), and spaces 

<StringLen> The number of characters in the result string. 
0 � 32 

<Theta> The orientation of the fixture. 
0 � 359 

<Timeout> The total amount of time (in seconds) to allow for a read, including retries and tuning of 
enabled Configs. 
 0 � 60 (default = 30) 

<TryLog> The Retry status of the Config during the last read. 
0 � 99,999 

<TuneLog> The Retry and Tune status of the Config during the last read. 
0 � 99,999 

<Value> The raw response score of the specified character in a read string. 
0 � 99,999 

<WafID> References the  data structure in spreadsheet cell A4. 
<Wide> (CharSize) The width of a 2D symbol or the average width of the characters in a string, as measured 

in pixels.  
8 � 80 (default = 15) 

<Wide> (Region) The width of the region (along the X-axis) where the wafer mark is expected to appear in 
the field of view.  
4 � 640 (default = 500) 
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7.4 Evaluate Extended Native Mode Commands 
(Actions) 

The following commands are used in conjunction with the Evaluate extended Native 
Mode command to remotely control an In-Sight 1700 from user-designed software. Each 
command returns a Status Code, the number of characters (in bytes, including Carriage 
Returns and Line Feeds) in the output that follows, and the results (in XML format). 

The status codes for all Evaluate commands are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-2 The command could not be executed. 

7.4.1 AcquireConfig 
AcquireConfig(<WafID>,<Config>) 

Acquires an image using the light settings in the specified Config. This command does 
not read. 

Inputs: WafID, Config 

Output: Status Code, # of bytes 

Sample Input and Output 
EV ACQUIRECONFIG(A4,0) 
 
1 
0 
 

7.4.2 ReadConfig 
ReadConfig(<WafID>,<Config>,<AcquireFlag>) 

Reads using the specified Config. 

Inputs: WafID, Config, AcquireFlag 

Outputs: Status Code, # of bytes, Passed, String, Score, TryLog, TuneLog, LastRead, 
NumPassed, NumFailed, NumTunePassed, NumTuneFailed, AvgScore, High, Wide, 
Theta, Char, Value (Orc), Row (Orc), Col (Orc) 
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Sample Input and Output 
EV READCONFIG(A4,0,0) 

1 
1702 
<Result Id="0"> 
  <Passed>1</Passed> 
  <String>6713H129S6A1</String> 
  <Score>395</Score> 
  <TryLog>0</TryLog> 
  <TuneLog>0</TuneLog> 
  <LastRead>10</LastRead> 
  <NumPassed>10</NumPassed> 
  <NumFailed>0</NumFailed> 
  <NumTunedPassed>0</NumTunedPassed> 
  <NumTuneFailed>0</NumTuneFailed> 
  <AvgScore>95</AvgScore> 
  <High>39</High> 
  <Wide>20</Wide> 
  <Theta>0</Theta> 
  <Orc Id="0"> 
    <Char>54</Char> 
    <Value>98</Value> 
    <Row>52</Row> 
    <Col>63</Col> 
  </Orc> 
  <Orc Id="1"> 
    <Char>55</Char> 
    <Value>97</Value> 
    <Row>51</Row> 
    <Col>99</Col> 
  </Orc> 
  <Orc Id="2"> 
    <Char>49</Char> 
    <Value>98</Value> 
    <Row>50</Row> 
    <Col>133</Col> 
  </Orc> 
  <Orc Id="3"> 
    <Char>51</Char> 
    <Value>95</Value> 
    <Row>52</Row> 
    <Col>168</Col> 
  </Orc> 
  <Orc Id="4"> 
    <Char>72</Char> 
    <Value>99</Value> 
    <Row>51</Row> 
    <Col>204</Col> 
  </Orc> 
  <Orc Id="5"> 
    <Char>49</Char> 
    <Value>99</Value> 
    <Row>51</Row> 
    <Col>240</Col> 
  </Orc> 
  <Orc Id="6"> 
    <Char>50</Char> 
    <Value>91</Value> 
    <Row>52</Row> 
    <Col>274</Col> 
  </Orc> 
  <Orc Id="7"> 
    <Char>57</Char> 
    <Value>93</Value> 
    <Row>51</Row> 
    <Col>310</Col> 
  </Orc> 
  <Orc Id="8"> 
    <Char>83</Char> 
    <Value>92</Value> 
    <Row>53</Row> 
    <Col>344</Col> 

</Orc> 
  <Orc Id="9"> 
    <Char>54</Char> 
    <Value>96</Value> 
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EV READCONFIG(A4,0,0) 

    <Row>51</Row> 
    <Col>381</Col> 
  </Orc> 
  <Orc Id="10"> 
    <Char>65</Char> 
    <Value>93</Value> 
    <Row>53</Row> 
    <Col>415</Col> 
  </Orc> 
  <Orc Id="11"> 
    <Char>49</Char> 
    <Value>96</Value> 
    <Row>52</Row> 
    <Col>452</Col> 
  </Orc> 
</Result> 

Other ReadConfig Functions 

GetConfigOrcChar(<WafID>,<Config>,<Char Index>) 
GetConfigOrcRow(<WafID>,<Config>,<Char Index>) 
GetConfigOrcCol(<WafID>,<Config>,<Char Index>) 
GetConfigOrcVal(<WafID>,<Config>,<Char Index>) 

7.4.3 TuneConfig 
TuneConfig(<WafID>,<Config>,<Flag>,<Bright>,<Dark>,<Size>) 

Tunes the specified Config. To accept the optimized settings when tuning is completed, 
resend the TuneConfig command a final time, setting the <Flag> input to "2". 

NOTE This command does not do an exhaustive tune; it only does one iteration of settings. The 
command may need to be sent multiple times obtain optimized settings. 

Inputs: WafID, Config, Flag, Bright, Dark, Size 

Outputs: Status Code, # of bytes, NumRead, Passed (Current), String (Current), Score 
(Current), Passed (Best), Best String (Best), Best Score (Best) 

Sample Input and Output 
EV TUNECONFIG(A4,0,1,1,1,1) 

 
1 
282 
<TuneStep Id="0" Percent="1"> 
  <NumRead>1</NumRead> 
  <Current> 
    <Passed>1</Passed> 
    <String>6713H129S6A1</String> 
    <Score>396</Score> 
  </Current> 
  <Best> 
    <Passed>1</Passed> 
    <String>6713H129S6A1</String> 
    <Score>396</Score> 
  </Best> 
</TuneStep> 
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7.4.4 ResetStats 
ResetStats(<WafID>) 

Reset all accumulated read statistics. 

Inputs: WafID 

Outputs: Status Code, # of bytes 

EV RESETSTATS(A4) 
 
1 
0 
 

7.5 Evaluate Extended Native Mode Commands 
(Get) 

The following commands are used to retrieve setting and read results from the Configs in 
a wafer ID job. Each command returns a Status Code, the number of characters (in 
bytes, including Carriage Returns and Line Feeds) in the output that follows, and the 
results (in XML format). 

The status codes for all Evaluate commands are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
�2 The command could not be executed. 

7.5.1 GetConfig 
GetConfig(<WafID>,<Config>) 

Returns the current settings for a Config. 

Inputs: WafID, Config 

Outputs: Status Code, # of bytes, Mark, Checksum, LightMode, LightPower, Orientation, 
Row (Region), Column (Region), High (Region), Wide (Region), High (Char), Wide 
(Char), FieldString, FieldDef, Color, Accept, Enable 
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Sample Input and Output 
EV GETCONFIG(A4,0) 
 
1 
470 
<Config Id="0"> 
  <Mark>4</Mark> 
  <Checksum>2</Checksum> 
  <LightMode>1</LightMode> 
  <LightPower>2</LightPower> 
  <Orientation>0</Orientation> 
  <Region> 
    <Row>280</Row> 
    <Col>45</Col> 
    <High>100</High> 
    <Wide>500</Wide> 
  </Region> 
  <CharSize> 
    <High>42</High> 
    <Wide>22</Wide> 
  </CharSize> 
  <FieldString>**********CS</FieldString> 
  <FieldDef></FieldDef> 
  <Color>2</Color> 
  <Accept>50</Accept> 
  <Enable>1</Enable> 
</Config> 
 

Other GetConfig Functions 

GetConfigMark(<WafID>,<Config>) 
GetConfigChecksum(<WafID>,<Config>) 
GetConfigLightMode(<WafID>,<Config>) 
GetConfigLightPower(<WafID>,<Config>) 
GetConfigRegionRow(<WafID>,<Config>) 
GetConfigRegionCol(<WafID>,<Config>) 
GetConfigRegionHigh(<WafID>,<Config>) 
GetConfigRegionWide(<WafID>,<Config>) 
GetConfigCharHigh(<WafID>,<Config>) 
GetConfigCharWide(<WafID>,<Config>) 
GetConfigFieldStr(<WafID>,<Config>) 
GetConfigFieldDef(<WafID>,<Config>) 
GetConfigColor(<WafID>,<Config>) 
GetConfigAccept(<WafID>,<Config>) 
GetConfigEnable(<WafID>,<Config>) 
GetConfigRetry(<WafID>,<Config>) 
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7.5.2 GetConfigResult 
GetConfig(<WafID>,<Config>) 

Returns the results of the most recent read performed by the specified Config. 

Inputs: WafID, Config 

Outputs: Status Code, # of bytes, Passed, String, Score, TryLog, TuneLog, LastRead, 
NumPassed, NumFailed, NumTunePassed, NumTuneFailed, AvgScore, High, Wide, 
Theta, Char (Orc), Value (Orc), Row (Orc), Col (Orc) 

Sample Input and Output 
EV GETCONFIGRESULT(A4,0) 

1 
1701 
<Result Id="0"> 
  <Passed>1</Passed> 
  <String>6713H129S6A1</String> 
  <Score>396</Score> 
  <TryLog>1</TryLog> 
  <TuneLog>0</TuneLog> 
  <LastRead>10</LastRead> 
  <NumPassed>4</NumPassed> 
  <NumFailed>0</NumFailed> 
  <NumTunePassed>0</NumTunePassed> 
  <NumTuneFailed>0</NumTuneFailed> 
  <AvgScore>96</AvgScore> 
  <High>40</High> 
  <Wide>21</Wide> 
  <Theta>0</Theta> 
  <Orc Id="0"> 
    <Char>54</Char> 
    <Value>96</Value> 
    <Row>51</Row> 
    <Col>25</Col> 
  </Orc> 
  <Orc Id="1"> 
    <Char>55</Char> 
    <Value>96</Value> 
    <Row>51</Row> 
    <Col>65</Col> 
  </Orc> 
  <Orc Id="2"> 
    <Char>49</Char> 
    <Value>98</Value> 
    <Row>52</Row> 
    <Col>105</Col> 
  </Orc> 
  <Orc Id="3"> 
    <Char>51</Char> 
    <Value>97</Value> 
    <Row>53</Row> 
    <Col>145</Col> 
  </Orc> 
  <Orc Id="4"> 
    <Char>72</Char> 
    <Value>99</Value> 
    <Row>53</Row> 
    <Col>187</Col> 
  </Orc> 
  <Orc Id="5"> 
    <Char>49</Char> 
    <Value>99</Value> 
    <Row>54</Row> 
    <Col>228</Col> 
  </Orc> 
  <Orc Id="6"> 
    <Char>50</Char> 
    <Value>94</Value> 
    <Row>54</Row> 
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EV GETCONFIGRESULT(A4,0) 

    <Col>269</Col> 
  </Orc> 
  <Orc Id="7"> 
    <Char>57</Char> 
    <Value>98</Value> 
    <Row>55</Row> 
    <Col>309</Col> 
  </Orc> 
  <Orc Id="8"> 
    <Char>83</Char> 
    <Value>88</Value> 
    <Row>56</Row> 
    <Col>350</Col> 

</Orc> 
  <Orc Id="9"> 
    <Char>54</Char> 
    <Value>98</Value> 
    <Row>56</Row> 
    <Col>391</Col> 
  </Orc> 
  <Orc Id="10"> 
    <Char>65</Char> 
    <Value>93</Value> 
    <Row>58</Row> 
    <Col>431</Col> 
  </Orc> 
  <Orc Id="11"> 
    <Char>49</Char> 
    <Value>98</Value> 
    <Row>57</Row> 
    <Col>471</Col> 
  </Orc> 
</Result> 
 

Other GetConfigResult Functions 

GetConfigString(<WafID>,<Config>) 
GetConfigStringLen(<WafID>,<Config>) 
GetConfigScore(<WafID>,<Config>) 
GetConfigPassed(<WafID>,<Config>) 
GetConfigHigh(<WafID>,<Config>) 
GetConfigWide(<WafID>,<Config>) 
GetConfigTheta(<WafID>,<Config>) 
GetConfigLastRead(<WafID>,<Config>) 
GetConfigNumPassed(<WafID>,<Config>) 
GetConfigNumFailed(<WafID>,<Config>) 
GetConfigNumTunePassed(<WafID>,<Config>) 
GetConfigNumTuneFailed(<WafID>,<Config>) 
GetConfigAvgScore(<WafID>,<Config>) 
GetConfigTryLog(<WafID>,<Config>) 
GetConfigTuneLog(<WafID>,<Config>) 
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7.5.3 GetMSBuffer 
GetMSBuffer (<Index>) 

Returns the Machine Status data stored in one of 8 indexed buffers within the 
MachineStatus stack. If the index is 0, the current Machine Status is returned. 

Input: Index 

Output:  MachineStatus, TimeAndDate, HostName, InSightModel, FirmwareVersion, 
BootTime, ActiveJob, JobLoadTime, Online, OperationalStatus, UserName,  
UserHostName, UserData.  

Sample Input and Output 
EV GETMSBUFFER(0) 

1 
540 
<MachineStatus> 
  <TimeAndDate>>08/15/2002 13:06:02</TimeAndDate> 
  <HostName>MyHost</HostName> 
  <InSightModel>1000</InSightModel> 
  <FirmwareVersion>2.40.01</FirmwareVersion> 
  <BootTime>08/15/2002 11:00:05</BootTime> 
  <ActiveJob>FTP://SYSTEM1/MyJob.job</ActiveJob> 
  <JobLoadTime>08/13/2002 13:00:00</JobLoadTime> 
  <Online>0</Online> 
  <OperationalStatus>MAINTENANCE</OperationalStatus> 
  <UserName>admin</UserName> 
  <UserHostName>SYSTEM1</UserHostName> 
  <UserData>PASS,SCORE=95,X=242,Y=348</UserData> 
</MachineStatus> 
 

 

7.5.4 GetWaferAll 
GetWaferAll(<WafID>) 

Returns all results for the most recent read, and settings for all Configs. 

Inputs: WafID 

Outputs: Status Code, # of bytes, BestConfig, Timeout, Order, AcqEnable, NumPassed, 
NumFailed, AvgScore Row (Fixture), Col (Fixture), Theta (Fixture), Mark, Checksum, 
LightMode, LightPower, Orientation, Row (Region), Col (Region), High (Region), Wide 
(Region), High (Char), Wide (Char), FieldString, FieldDef, Color, Accept, Enable, Passed, 
String, Score, TryLog, TuneLog, LastRead, NumPassed, NumFailed, NumTunePassed, 
NumTuneFailed, AvgScore, High, Wide, Theta, Char (Orc) Value (Orc), Row, (Orc), Col 
(Orc) 

Sample Input and Output 
EV GETWAFERALL(A4) 

1 
23626 
<Wafer> 
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EV GETWAFERALL(A4) 

  <BestConfig>0</BestConfig> 
  <Timeout>30</Timeout> 
  <Order>0</Order> 
  <AcqEnable>1</AcqEnable> 
  <NumPassed>4</NumPassed> 
  <NumFailed>0</NumFailed> 
  <AvgScore>96</AvgScore> 
  <Fixture> 
    <Row>0</Row> 
    <Col>0</Col> 
    <Theta>0</Theta> 
  </Fixture> 
  <Config Id="0"> 
    <Mark>4</Mark> 
    <Checksum>2</Checksum> 
    <LightMode>1</LightMode> 
    <LightPower>2</LightPower> 
    <Orientation>0</Orientation> 
    <Region> 
      <Row>280</Row> 
      <Col>45</Col> 
      <High>100</High> 
      <Wide>500</Wide> 
    </Region> 
    <CharSize> 
      <High>42</High> 
      <Wide>22</Wide> 
    </CharSize> 
    <FieldString>**********CS</FieldString> 
    <FieldDef></FieldDef> 
    <Color>2</Color> 
    <Accept>50</Accept> 
    <Enable>1</Enable> 
  </Config> 
  <Result Id="0"> 
    <Passed>1</Passed> 
    <String>6713H129S6A1</String> 
    <Score>396</Score> 
    <TryLog>1</TryLog> 
    <TuneLog>0</TuneLog> 
    <LastRead>10</LastRead> 
    <NumPassed>4</NumPassed> 
    <NumFailed>0</NumFailed> 
    <NumTunePassed>0</NumTunePassed> 
    <NumTuneFailed>0</NumTuneFailed> 
    <AvgScore>96</AvgScore> 
    <High>40</High> 
    <Wide>21</Wide> 
    <Theta>0</Theta> 
    <Orc Id="0"> 
      <Char>54</Char> 
      <Value>96</Value> 
      <Row>51</Row> 
      <Col>25</Col> 
    </Orc> 
    <Orc Id="1"> 
      <Char>55</Char> 
      <Value>96</Value> 
      <Row>51</Row> 
      <Col>65</Col> 
    </Orc> 
    <Orc Id="2"> 
      <Char>49</Char> 
      <Value>98</Value> 
      <Row>52</Row> 
      <Col>105</Col> 
    </Orc> 
    <Orc Id="3"> 
      <Char>51</Char> 
      <Value>97</Value> 
      <Row>53</Row> 
      <Col>145</Col> 
    </Orc> 
    <Orc Id="4"> 
      <Char>72</Char> 
      <Value>99</Value> 
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EV GETWAFERALL(A4) 

      <Row>53</Row> 
      <Col>187</Col> 
    </Orc> 
    <Orc Id="5"> 
      <Char>49</Char> 
      <Value>99</Value> 
      <Row>54</Row> 
      <Col>228</Col> 
    </Orc> 
    <Orc Id="6"> 
      <Char>50</Char> 
      <Value>94</Value> 
      <Row>54</Row> 
      <Col>269</Col> 
    </Orc> 
    <Orc Id="7"> 
      <Char>57</Char> 
      <Value>98</Value> 
      <Row>55</Row> 
      <Col>309</Col> 
    </Orc> 
    <Orc Id="8"> 
      <Char>83</Char> 
      <Value>88</Value> 
      <Row>56</Row> 
      <Col>350</Col> 
    </Orc> 
    <Orc Id="9"> 
      <Char>54</Char> 
      <Value>98</Value> 
      <Row>56</Row> 
      <Col>391</Col> 
    </Orc> 
    <Orc Id="10"> 
      <Char>65</Char> 
      <Value>93</Value> 
      <Row>58</Row> 
      <Col>431</Col> 
    </Orc> 
    <Orc Id="11"> 
      <Char>49</Char> 
      <Value>98</Value> 
      <Row>57</Row> 
      <Col>471</Col> 
    </Orc> 

</Result> 
... (<Config Id="1"> through <Config Id="9" omitted>) 

</Wafer> 
 

Other GetWafer Functions 

GetWaferTimeout(<WafID>) 
GetWaferOrder(<WafID>) 
GetWaferAcqEnable(<WafID>) 
GetWaferBestConfig(<WafID>) 
GetWaferFixRow(<WafID>) 
GetWaferFixCol(<WafID>) 
GetWaferFixTheta(<WafID>) 
GetWaferNumPassed(<WafID>) 
GetWaferNumFailed(<WafID>) 
GetWaferAveScore(<WafID>) 
GetWaferString(<WafID>) 
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7.5.5 GetWaferSummary 
GetWaferSummary(<WafID>) 

Returns a summary of the results for the most recent read. 

NOTE A ConfigLog will be returned for all Enabled Configs. 

Inputs: WafID 

Outputs: Status Code, # of bytes, BestConfig, Passed, String, Score, Row (Region), Col 
(Region), High (Region), Wide (Region), NumPassed, NumFailed, AvgScore, ReadLog, 
Passed (ConfigLog), String (ConfigLog), Score (ConfigLog), TryLog (ConfigLog), 
TuneLog (ConfigLog), NumPassed (ConfigLog), NumFailed (ConfigLog), 
NumTunedPassed (ConfigLog), NumTuneFailed (ConfigLog), AvgScore (ConfigLog) 

Sample Input and Output 
EV GETWAFERSUMMARY(A4) 

1 
746 
<WaferSummary> 
  <BestConfig>0</BestConfig> 
  <Passed>1</Passed> 
  <String>6713H129S6A1</String> 
  <Score>396</Score> 
  <Region> 
    <Row>280</Row> 
    <Col>45</Col> 
    <High>100</High> 
    <Wide>500</Wide> 
  </Region> 
  <NumPassed>4</NumPassed> 
  <NumFailed>0</NumFailed> 
  <AvgScore>96</AvgScore> 
  <ReadLog></ReadLog> 
  <ConfigLog Id="0"> 
    <Passed>1</Passed> 
    <String>6713H129S6A1</String> 
    <Score>396</Score> 
    <TryLog>1</TryLog> 
    <TuneLog>0</TuneLog> 
    <NumPassed>4</NumPassed> 
    <NumFailed>0</NumFailed> 
    <NumTunedPassed>0</NumTunedPassed> 
    <NumTuneFailed>0</NumTuneFailed> 
    <AvgScore>96</AvgScore> 
  </ConfigLog> 
</WaferSummary> 



Section 7: Native Mode Commands In-Sight® 1700 Series Wafer Reader 

80  

7.6 Evaluate Extended Native Mode Commands 
(Set) 

The following commands are used to change Config settings in a wafer ID job. Each 
command returns a Status Code, and the number of characters (in bytes, including 
Carriage Returns and Line Feeds) in the output that follows. 

The status codes for all Evaluate commands are: 

STATUS CODE DESCRIPTION 
1 The command was executed successfully. 
0 Unrecognized command. 
-2 The command could not be executed. 

7.6.1 SetConfigAccept 
SetConfigAccept(<WafID>,<Config>,<Accept>) 

Sets the minimum response threshold for the raw reading score of the specified Config. 

Inputs: WafID, Config, Accept 

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGACCEPT(A4,0,50) 

1 
0 

7.6.2 SetConfigCharSize 
SetConfigCharSize(<WafID>,<Config>,<High>,<Wide>) 

Sets the expected size of an individual character or 2D mark for the specified Config. 

Inputs: WafID, Config, High, Wide  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGCHARSIZE(A4,0,40,20) 

1 
0 
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7.6.3 SetConfigChecksum 
SetConfigChecksum(<WafID>,<Config>,<Checksum>) 

Selects the method by which the read result from a character string will be validated to 
ensure reliability, and establishes the scoring basis for determining the pass/fail status of 
the read. 

Inputs: WafID, Config, Checksum  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGCHECKSUM(A4,0,1) 

1 
0 

7.6.4 SetConfigColor 
SetConfigColor(<WafID>,<Config>,<Color>) 

Sets the expected color of the wafer mark. 

Inputs: WafID, Config, Color 

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGCOLOR(A4,0,1) 

1 
0 

7.6.5 SetConfigEnable 
SetConfigEnable(<WafID>,<Config>,<Enable>) 

Determines whether the specified Config will be used during the retry sequence at 
runtime. 

Inputs: WafID, Config, Enable  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGENABLE(A4,0,1) 

1 
0 
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7.6.6 SetConfigFieldDef 
SetConfigFieldDef(<WafID>,<Config>,<FieldDef>) 

Defines the Field String when Mark specifies a character string or barcode. 

NOTE The FieldDef Input must be set off with quotation marks. 

Inputs: WafID, Config, FieldDef  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGFIELDDEF(A4,0,"A=A;B=B")   

1 
0 

7.6.7 SetConfigFieldString 
SetConfigFieldString(<WafID>,<Config>,<FieldString>) 

Specifies the number of characters contained in the character string or encoded in a 
barcode. 

NOTE The FieldString Input must be set off with quotation marks. 

Inputs: WafID, Config, FieldString  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGFIELDSTRING(A 4,0,"************") 

1 
0 

7.6.8 SetConfigLightMode 
SetConfigLightMode(<WafID>,<Config>,<LightMode>) 

Specifies either a Bright Field or a Dark Field illumination effect on the mark. 

Inputs: WafID, Config, LightMode  

Outputs: Status Code, # of bytes 
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Sample Input and Output 
EV SETCONFIGLIGHTMODE(A4,0,11) 

1 
0 

7.6.9 SetConfigLightPower 
SetConfigLightPower(<WafID>,<Config>,<LightPower>) 

Controls the effective intensity of the LEDs on the mark by increasing the exposure time 
of the 1700�s CCD imager. 

Inputs: WafID, Config, LightPower  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGLIGHTPOWER(A4,0,25.123) 

1 
0 

7.6.10 SetConfigMark 
SetConfigMark(<WafID>,<Config>,<Mark>) 

Specifies the type of wafer mark the selected Config will read. 

Inputs: WafID, Config, Mark 

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGMARK(A4,0,1) 

1 
0 

7.6.11 SetConfigRegion 
SetConfigRegion(<WafID>,<Config>,<Row>,<Col>,<High>,<Wide>) 

Sets the region where the wafer mark is expected to appear in the field of view for the 
specified Config. 

Inputs: WafID, Config, Row, Col, High, Wide  

Outputs: Status Code, # of bytes 
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Sample Input and Output 
EV SETCONFIGREGION(A4,0,150,60,100,500) 

1 
0 

7.6.12 SetConfigRetry 
SetConfigRetry(<WafID>,<Config>,<Retry>) 

Specifies how the Config will be used during the retry sequence at runtime. 

Inputs: WafID, Config, Retry  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETCONFIGRETRY(A4,0,1) 

1 
0 

7.6.13 SetWaferAcqEnable 
SetWaferAcqEnable(<WafID>,<AcqEnable>) 

Disables image acquisition to allow a test read from the last image acquired, or from an 
image file, when the reader is offline. The Light Mode and Light Power settings are 
temporarily disabled. 

Inputs: WafID, AcqEnable  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETWAFERACQENABLE(A4,0) 

1 
0 

7.6.14 SetWaferOrder 
SetWaferOrder(<WafID>,<Order>) 

The order in which enabled Configs will be tried until a successful read can be obtained. 

Inputs: WafID, Order  

Outputs: Status Code, # of bytes 
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Sample Input and Output 
EV SETWAFERORDER(A4,0) 

1 
0 

7.6.15 SetWaferTimeout 
SetWaferTimeout(<WafID>,<Timeout>) 

Specifies the total amount of time (in seconds) to allow for a read, including retries and 
tuning of enabled Configs. 

Inputs: WafID, Timeout  

Outputs: Status Code, # of bytes 

Sample Input and Output 
EV SETWAFERTIMEOUT(A4,45) 

1 
0 
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8.1 General Specifications 
Table 8-1: In-Sight 1701 Wafer Reader General Specifications 

SPECIFICATION DESCRIPTION 
Configurations • Vertical Mount w/ factory-set 10 mm Working Distance (P/N 800-5797-1) 

• Vertical Mount w/ factory-set 50 mm Working Distance (P/N 800-5798-1) 
• Optional Horizontal Mirror Mount (800-5796-1) 

Firmware In-Sight version 2.40 and later 
Supported Wafer Marks Standards 

SEMI font SEMI M12, M13, M1.15 
IBM font N/A OCR 
Triple font N/A 

2D Data Matrix� (ECC 200, 8 x 32) SEMI T7 and M1.15 

Reading Capability 

Barcode BC 412 and IBM 412 SEMI T1-95 
Job/Program 8MB non-volatile flash memory; Unlimited storage via remote network device Memory 
Image/Processing 16MB SDRAM 

1/3-inch CCD (5.80 x 4.92 mm, 6 mm diagonal) 
1024 x 768 pixel display (307,200 sq. pixels, 4.65 x 4.65 µm) 

Image Sensor 

Electronic shutter speed: 64 µs to 33 ms; Up to 18 frames per second 
Rapid reset, progressive scan (supports partial scan), full-frame integration 
256 grey levels (8 bits/sec) 

 Acquisition 

Gain controlled by software 
Lighting/Optics  Field of View: 31 mm (W) x 23 mm (H) 

Working Distance: adjustable, w/ factory-set options of 10 or 50 mm (Vertical) 
Illumination Area: 31 mm (W) x 19 mm (H) (Nominal; depends on Light Mode) 
Red LEDs, 626 nm wavelength, w/ Bright Field and Dark Field modes 
Variable intensity controlled through software 

I/O* Trigger 1 opto-isolated, acquisition trigger input 
  Remote software commands via Ethernet and RS232 

None built-in  Discrete Inputs 
8 inputs available using optional I/O Expansion Module (P/N 800-5758-1) 
Unlimited inputs using optional Ethernet I/O Module (P/N CIO-ENET-IN4) 
None built-in  Discrete Outputs 
8 outputs available using optional I/O Expansion Module (P/N 800-5758-1) 
Unlimited outputs using optional Ethernet I/O Module (P/N CIO-ENET-OUT4) 

 Status LEDs 1 Network Traffic, 1 Network Status, 1 Network Speed, 2 User-Configurable 
Network 1 Ethernet port, 10/100 BaseT, TCP/IP protocol. Supports DHCP (factory default) or 

static IP address. Manual reset switch disable DHCP and forces factory-assigned, static 
IP address. 

Serial 1 RS-232C port (1200 to 115,200 baud rates) 

Communications 

Protocols In-Sight, Native Mode and Electroglas 
Power 24 ± 10% VDC; 125mA (illumination off) to 200mA (illumination on) 

Material Aluminum housing, black anodized 
Mounting Four 6.5 mm deep M4 threaded mounting holes (two per side) 
Dimensions 116.7 mm (4.60 in) x 69.9 mm (2.75 in) x 57.6 mm (2.27 in) 

Horizontal configuration length: 141.3 mm (5.55 in) 

Mechanical 

Weight 416.7 g (14.7 oz) 
Temperature 10 to 45°C (Operating), -10 to 65°C (Storage) Environmental 
Humidity 10 to 90%, non-condensing (Operating and Storage) 

Certifications CE, CUL 
* See Section 8.2: I/O Specifications for more information. 



In-Sight® 1700 Series Wafer Reader Section 8: Specifications 

 89 

Table 8-2: In-Sight 1700 Wafer Reader General Specifications 

SPECIFICATION DESCRIPTION 
Configurations • Vertical Mount (P/N 800-5748-10) 

• Horizontal Mount (P/N 800-5748-20) 
Firmware In-Sight version 2.13 and later 

Supported Wafer Marks Standards 
SEMI font SEMI M12, M13, M1.15 
IBM font N/A OCR 
Triple font N/A 

2D Data Matrix� (ECC 200, 8 x 32) SEMI T7 and M1.15 

Reading Capability 

Barcode BC 412 and IBM 412 SEMI T1-95 
Job/Program 4MB non-volatile flash memory; Unlimited storage via remote network device Memory 
Image/Processing 16MB SDRAM 

1/3-inch CCD (5.84 x 4.94 mm, 6 mm diagonal) 
640 x 480 pixel display ((307,200 sq. pixels, 7.4 x 7.4 µm) 

Image Sensor 

Electronic shutter speed: 64 µs to 33 ms; Up to 30 frames per second 
Rapid reset, progressive scan (supports partial scan), full-frame integration 
256 grey levels (8 bits/sec) 

 Acquisition 

Gain controlled by software 
Lighting/Optics  Field of View: 25 mm (W) x 19 mm (H) 

Working Distance: 10 mm (Horizontal); 15 mm (Vertical) 
Depth of focus: ± 3 mm 
Illumination Area: 25 mm (W) x 10 mm (H) (Nominal; depends on Light Mode) 
Red LEDs, 626 nm wavelength, w/ Bright Field and Dark Field modes 
Variable intensity controlled through software 

I/O* Trigger 1 opto-isolated, acquisition trigger input 
  Remote software commands via Ethernet and RS232 

None built-in  Discrete Inputs 
8 inputs available using optional I/O Expansion Module (P/N 800-5758-x) 
Unlimited inputs using optional Ethernet I/O Module (P/N CIO-ENET-IN4) 
None built-in  Discrete Outputs 
8 outputs available using optional I/O Expansion Module (P/N 800-5758- x) 
Unlimited outputs using optional Ethernet I/O Module (P/N CIO-ENET-OUT4) 

 Status LEDs 1 Network Traffic, 1 Network Status, 1 Network Speed, 2 User-Configurable 
Network 1 Ethernet port, 10/100 BaseT, TCP/IP protocol. Supports DHCP (factory default) or 

static IP address. Manual reset switch disable DHCP and forces factory-assigned, static 
IP address. 

Serial 1 RS-232C port (1200 to 115,200 baud rates) 

Communications 

Protocols In-Sight, Native Mode and Electroglas 
Power 24 ± 10% VDC; 125mA (illumination off) to 200mA (illumination on) 

Material Aluminum housing, black anodized 
Mounting Four 6.5 mm deep M4 threaded mounting holes (two per side) 
Dimensions 116.7 mm (4.60 in) x 69.9 mm (2.75 in) x 57.6 mm (2.27 in) 

Mechanical 

Weight 416.7 g (14.7 oz) 
Temperature 10 to 45°C (Operating), -10 to 65°C (Storage) Environmental 
Humidity 10 to 90%, non-condensing (Operating and Storage) 

Certifications CE, CUL 
* See Section 8.2: I/O Specifications for more information. 



Section 8: Specifications In-Sight® 1700 Series Wafer Reader 

90  

8.2 I/O Specifications 
The 1700 Wafer Reader features one built-in acquisition trigger input and two user-
configurable LED outputs for general-purpose use. 

8.2.1 Breakout Port Pin Assignments 
Table 8-3 lists the pin assignment for each of the 8 signal lines of the In-Sight 1700 
Breakout Port (labeled �24VDC�) according to each method of access. 

Table 8-3: Breakout Port Pin Assignments 

IN-SIGHT 
BREAKOUT PORT 

PIN 
SIGNAL 

BREAKOUT 
CABLE 

WIRE COLOR 
BREAKOUT MODULE* 

TERMINALS 
EXPANSION MODULE* 

TERMINALS 

1 +24VDC White-Green 6, 8, 10, 12, 14, 15, 16 (+24V) +24V 

2 Trigger + Green 5 (TRG+) TRG+ 

3 Trigger � White-Orange 4 (TRG-) TRG- 

4 CTS Blue RS232 serial (9-pin D-sub 
connector) 

RS232 remote (9-pin D-sub 
connector) 

5 RTS White-Blue RS232 serial (9-pin D-sub 
connector) 

RS232 remote (9-pin D-sub 
connector) 

6 Serial 
Receive Orange RS232 serial (9-pin D-sub 

connector) 
RS232 remote (9-pin D-sub 

connector) 

7 Serial 
Transmit White-Brown RS232 serial (9-pin D-sub 

connector) 
RS232 remote (9-pin D-sub 

connector) 

8 Ground Brown 1, 2, 3 (GND) GND 

* Refer to the In-Sight Breakout Module Installation and Reference (P/N 597-0008-xx) and the In-Sight I/O Expansion Module 
Installation and Reference (P/N 597-0013-xx) for more detailed information. 

8.2.2 Acquisition Trigger Input 
Table 8-4: Acquisition Trigger Input Specifications 

SPECIFICATION DESCRIPTION 
ON 20 to 30V (24V nominal) VOLTAGE 
OFF 0 to 3V (12V nominal threshold) 
ON 0.9 to 1.3mA 
OFF <150�A 
Resistance ~22,000 Ohms 

CURRENT 

For higher current add external resistor (for example, 2.2k�, 0.5W for 12mA) across inputs. 

DELAY 250 µSec latency between leading edge of trigger and start of acquisition. 
Input pulse should be minimum of 1 ms wide. 

The acquisition trigger input is opto-isolated. To trigger from an NPN (pull-down) type 
photo-detector or PLC output, connect pin 2 (TRG+) to +24V and connect pin 3 (TRG-) to 
the output of the detector. When the output turns ON, it pulls TRG- down to 0V, turning 
the opto-coupler ON. To trigger from a PNP (pull-up) photo-detector or PLC output, 
connect pin 2 (TRG+) to the output of the detector and connect pin 3 (TRG-) to 0V. When 
the output turns ON, it pulls TRG+ up to 24V, turning the opto-coupler ON. 
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Figure 8-1: Acquisition Trigger Input Schematic 

8.2.3 Status LEDs 
As shown in Figure 8-2, the In-Sight 1700 reader provides six status LEDs; two LEDs are 
user-configurable outputs. The function of each LED is listed in Table 8-5. 

 

Figure 8-2: LED Outputs 

Table 8-5: LED Function 

LED NUMBER LED COLOR LED FUNCTION DESCRIPTION 
1 Red Network Traffic Flashes when receiving data. 
2 Red Network Status On when connected to the network. 
3 Red Network Speed On for 100Mbs network connection; off for 10Mbs. 

4 Green User-Configurable User-configurable using Discrete Output Line 4 (Line 10 when 
using I/O Expansion Module). 

5 Red User-Configurable User-configurable using Discrete Output Line 5 (Line 11 when 
using I/O Expansion Module). 

6 Red Power On when power is connected. 
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The WriteDiscrete function (Input/Output-->Discrete) can be inserted in the spreadsheet 
job to control the state of the two user-configurable LEDs based on an event. The output 
Type can be specified in the Discrete Output dialog in the In-Sight PC Host (Figure 8-3). 

 

Figure 8-3: Default Discrete Output dialog in In-Sight PC Host 
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8.3 CAT5 Network Cable Specifications 
Cognex-supplied, straight-pinned and crossover network patch cables meet 
CAT5/CAT5e specifications using 568-B standard wire pairing. 

Table 8-6: CAT5/CAT5e Network Cable Wiring 

STRAIGHT-PINNED CROSSOVER 

RJ-45 Connector (A) RJ-45 Connector (B) Connector (A) Connector (B) 
1 1 1 3 
2 2 2 6 
3 3 3 1 
4 4 4 5 
5 5 5 4 
6 6 6 2 
7 7 7 8 
8 8 8 7 

Table 8-7: CAT5/CAT5e Network Cable 568-B Wire Pairs 

PAIR # WIRE PAIRS 
1 4 � 5 
2 1 � 2 
3 3 � 6 
4 7 � 8 
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8.4 Mechanical Specifications 
The following sections present dimensional drawings for the In-Sight 1700 series vision 
sensors. 

NOTE All dimensions are shown in millimeters (inches). 
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8.4.1 In-Sight 1701 Wafer Reader Dimensions  

 

Figure 8-4: 1701 Wafer Reader Dimensions 
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Figure 8-5: 1701 Wafer Reader Dimensions with Horizontal Mirror Mount 
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8.4.2 In-Sight 1700 Wafer Reader Dimensions 

 

Figure 8-6: 1700 Wafer Reader Dimensions 
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Appendix A 
 

The Default Job (WAFID00.JOB) 
The Java applet, WAFID00.JAR, requires a compatible spreadsheet job file to be loaded 
on the 1700 reader to function correctly. By default, this job file is WAFID00.JOB. To 
connect to a 1700 from the browser interface, the reader's Startup settings must be 
configured to automatically load the default job, or another job that has been previously 
saved using the browser interface. 

As noted in Section 4.1, advanced users may customize some cells in the spreadsheet of 
a browser interface-compatible job. In general, cells may be safely added to the 
spreadsheet. However, the predefined functions and formulas in the spreadsheet must 
not be rearranged, deleted, or otherwise changed in such a way as to break compatibility 
with the Java applet. And under no circumstance should the cells in Rows 21 through 49 
(hidden by default) ever be modified. 
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Appendix B 

Updating the Reader�s Firmware 
Install the In-Sight PC Host program, update the 1700�s firmware, and then manually 
install the .JAR, .HTM, .JOB, and .SET files in flash memory. 

After installing and running the In-Sight PC Host, as described in Section 2.3, follow 
these steps to update the 1700 reader�s firmware: 

NOTE This update process will erase all jobs. Make sure that all jobs are backed up on the network prior 
to starting the firmware upgrade. 

1 Open the System menu and select Logon. 

2 In the Logon dialog, browse through the list of In-Sight host names on the network 
and select the name of the 1700 reader to upgrade. Click OK to logon to the selected 
1700. 

3 While logged on to the 1700, open the System menu and select Save & Load. 

4 In the Save & Load dialog, open the drop-down list of file types in the upper-left 
corner and select Firmware. 

5 Click on <Network> to browse through the list of In-Sight host names on the network. 
Select the host name of the PC running the In-Sight PC Host program. 

6 Select the is1700.upd (is1701.upd for 1701 reader) filename. 

7 Click the Load $$$$ button to begin the firmware update process. 

8 A Warning dialog will appear. Verify the versions of firmware, then click Yes. 

After the update process is complete, the 1700 will restart and the PC Host program will 
automatically log back on. 

1 Open the System menu and select Version to confirm that the 1700 now has the 
correct firmware version installed. 

2 Open the System menu again and select Settings!!!!. 

3 From the Settings menu, select Network. Record the IP Address (you will need this 
to complete the steps in the following sections). 

4 Close the In-Sight PC Host program and proceed to the next section (Install files to 
1700 flash memory). 
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Install files to 1700 flash memory 
After the 1700 reader�s firmware has been updated, the .HTM, .JAR, .JOB and .SET files 
included in the installation package must be copied to the reader�s flash memory before it 
can be accessed via web browser. The required files are copied into flash through an 
FTP login from a remote host on the network. 

To copy required files from a web browser: 

1 Open an FTP session and login to the target reader by typing ftp:// followed by the 
reader�s IP Address into the browser�s Address bar (for example, ftp://192.168.0.1). A 
Login dialog appears (Figure B-0-1). 

 

Figure B-0-1: FTP Login dialog 

2 In the Login dialog, enter the default User Name admin, then click OK to login. 

3 If the FTP login to the 1700 is successful, all of the files currently installed in In-Sight 
flash memory are displayed in the browser window, as shown in Figure B-0-2. 

 

Figure B-0-2: Installed 1700 files 



In-Sight® 1700 Series Wafer Reader Appendix B: Updating the Reader 

 103 

4 Locate the .HTM, .JAR, .JOB, and .SET files in the directory into which you 
previously installed the In-Sight PC Host (C:\InSight2\1700 by default). Copy and 
paste (or drag and drop) these files to the browser window, then refresh the view; the 
selected files have been copied to 1700 flash memory and now appear in the 
browser window, as shown in Figure B-0-3. 

 

Figure B-0-3: Installed 1700 files 

To FTP files from an FTP prompt (in Windows): 

1 Open a DOS prompt and change the directory to C:\InSight2\1700. Open an FTP 
session and login to the target reader by typing ftp followed by the IP Address (for 
example, ftp 192.168.0.1), as shown in Figure B-0-4. 

NOTE To connect to a 1700 using FTP from a non-Windows host, first copy the required files from 
the C:\InSight2 directory on the PC to the FTP server, then open the FTP session. 

 

Figure B-0-4: FTP command prompt in Windows 

ftp://ftp 192.168.0.0/
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2 Enter the default User Name, admin. 

3 When logged in, copy the .HTM, .JAR, .JOB, and .SET files from their location on the 
FTP server to the 1700 by typing mput followed by the name of the file (for example, 
mput *.jar copies the two .JAR files). 

4 After all files have been copied, close the FTP prompt. 

Once the files have been copied to the reader�s flash memory, load the default job into 
the spreadsheet using the PC Host�s Save & Load dialog. 
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Appendix C 

Configuring Microsoft Windows Network Settings 
This section provides information on how to configure Microsoft Windows network 
settings to connect to a 1700 reader using the In-Sight PC Host program. The steps listed 
below and the example dialogs are specific to Windows NT 4.0. The exact steps required 
may vary slightly in Windows XP, 2000, Me, and 98SE. 

To configure Windows network settings: 

1 Verify the PC has a TCP/IP protocol installed. 

2 Close all programs on the PC except Windows NT. 

3 Click Start, click Settings, and then click on the Control Panel shortcut to open the 
Control Panel icon group. 

4 Click the Network icon to open the Network dialog. 

5 Select the Protocols tab (Figure C-0-1). If TCP/IP Protocol appears in this list, skip 
steps 0 and 7. 

 

Figure C-0-1: Windows Network dialog, Protocols tab 
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6 If TCP/IP is not on the list of installed protocols, click Add to open the Select Network 
Protocol dialog (Figure C-0-2). 

 

Figure C-0-2: Select Network Protocol dialog 

7 Select TCP/IP Protocol and click OK. Windows NT will install the protocol and return 
to the Network dialog. 

8 Configure the IP Address and Subnet Mask. 

9 Highlight TCP/IP Protocol in the Protocols tab and click Properties to open the 
Microsoft TCP/IP Properties dialog (Figure C-0-3): 

  

Figure C-0-3: Microsoft TCP/IP Properties Dialog 
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10 Click the Specify an IP address radio button. The IP Address and Subnet Mask fields, 
which are grayed-out when DHCP is enabled, become active. 

11 Enter an appropriate Subnet Mask. The Subnet Mask defines which part of the 1700 
reader�s IP Address refers to the network and which part refers to the host. The 
network part of the IP address is the same for all hosts on the same subnet, and the 
remainder is unique to each host. The default Subnet Mask setting of 255.255.255.0 
is usually appropriate. 

12 Click OK twice, then restart Windows if prompted to do so. 
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Appendix D 

Using the I/O Expansion Module 
Before the I/O Expansion Module (P/N 800-5758) can be used, the In-Sight 1700 
reader�s settings must be configured to recognize the availability of the additional inputs 
and outputs, as well as the added serial hardware handshake capability. 

To configure a 1700 reader to recognize the I/O Expansion Module: 

1 Physically connect the I/O Expansion Module to the In-Sight 1700 reader, as 
described previously in Section 2.1.4: Connecting the I/O Expansion Module. 

2 From your PC, open the In-Sight PC Host program and logon to the reader. 

3 Open the System menu. 

 

Figure D-0-1: System menu 
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4 Select Settings to open the Settings menu. 

 

Figure D-0-2: Settings menu 

5 Select Discrete Output to open the Discrete Output dialog. 

 

Figure D-0-3: Discrete Output dialog, default configuration 
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6 From the drop-down list beside the OK button, select I/O Expansion Module. The 
Discrete Output dialog will be automatically reconfigured to correspond to the I/O 
Expansion Module, as shown in Figure D-0-4. 

NOTE When an existing .JOB file containing a WriteDiscrete function is loaded on an In-Sight 1700 
reader to which the I/O Expansion Module has just been added, the Start Bit and Number of 
Bits parameters in WriteDiscrete must be changed to reflect the new configuration of the I/O 
lines. For example, the physical output lines 4 and 5 become lines 10 and 11 (Green and 
Yellow LEDs) when the I/O Expansion Module is enabled. 

 

Figure D-0-4: Discrete Output dialog, I/O Expansion configuration 

7 Select OK to copy the new settings to the 1700 reader�s flash RAM. 

NOTE An error message will appear if the I/O Expansion Module is not attached to the 1700 reader, 
and the Discrete Output dialog will return to its default configuration. Verify that the I/O 
Expansion Module is connected as described in Section 2.1.4, then repeat steps 1 � 7 as 
described above. 

Alternatively, the sensor can be configured to use the I/O Expansion Module by opening 
the Discrete Input dialog and following steps 6 and 7, as described above. 

Once the I/O Expansion Module is selected in either the Discrete Input or Discrete Output 
dialogs, it is automatically enabled for both inputs and outputs, and hardware 
handshaking may be used in serial communications. 

Refer to the In-Sight Guide & Reference HTML Help file installed with the In-Sight PC 
Host for details on using the Discrete and Serial Input/Output functions in the In-Sight 
spreadsheet. 
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Appendix E 

1701 Wafer Reader Installation Options 
1701 Horizontal Mirror Attachment 
The optional horizontal mirror attachment (P/N 800-5796) allows the reader to be 
installed in top or bottom-side reading applications where a low mounting profile is 
required. 

The horizontal mirror attachment can be mounted face-up or face-down (see Figure 
E-0-1). 

To attach the mirror mount: 

1 Align holes of the mirror attachment to holes on the front plate of the 1701 reader. 

2 Insert the two M3 X 14mm hex head screws (provided) through the mirror mount, into 
the front plate. 
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3 Tighten screws with a 2.5 mm Allen wrench. 

 

Figure E-0-1: Attaching the 1701 Horizontal Mirror Mount 
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As shown in Figure E-0-2, the horizontal mirror attachment lengthens the optical path by 
23.9 mm. To compensate, the working distance of the reader in the horizontal 
configuration will be 23.9 mm closer to the wafer than a reader mounted vertically with 
the same focal setting. The working distance for the vertical configuration is measured 
from the bottom of the reader to the top of the wafer. 

NOTE The Image Orientation may need to be adjusted, depending on the configuration of the reader and 
the mirror attachment sating. Refer to Section 3.4.8: Image Orientation for more information. 

 

Figure E-0-2: Working Distances in Horizontal and Vertical Mounting Configurations 
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Table E-1 shows examples of the 1701 reader�s vertical working distances and the 
corresponding horizontal working distances required if no focal adjustment is made. 

Table E-1: Working Distances 

VERTICAL WORKING DISTANCE (MM) CORRESPONDING HORIZONTAL 
WORKING DISTANCE (MM) 

5.0 N/A 

10.0* N/A 

15.0 N/A 
20.0 N/A 
25.0 1.1 
30.0 6.1 

40.0 16.1 

50.0* 26.1 

60.0 36.1 
70.0 46.1 
80.0 56.1 

* Indicates factory-set working distances 

Adjusting the Focus on the 1701 
The recommended working distance range is 1 to 80 mm for the 1701 reader in the 
vertical position. If using the horizontal mirror mount, the recommended working distance 
range is 1 to 56.1 mm. 

Once the working distance is established, the focus can be adjusted using the focus 
adjustment screw (M3 hex screw), located in the center of the 1701 reader�s front face 
plate (see Figure E-0-3). To adjust the focus, use a 2.5 mm Allen wrench. Turn the focus 
adjustment screw clock-wise if the reader is moved closer to the wafer; turn the screw 
counter clock-wise if the reader is moved farther away from the wafer. 

 

Figure E-0-3: Location of Focus Adjustment Screw 
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Image Artifacts 
Under certain conditions, horizontal lines may be observed in the image (Figure E-0-4). 
These lines are artifacts of the reader�s optical design. They are most visible at a working 
distance of approximately 30 mm, when the Light Mode setting is Dark Field (for more 
information of Light Modes, see Section 3.4.9). In most cases, these lines will have no 
impact on reading performance. If desired, position the mark in an area of the field of 
view that is free of artifacts. To reduce the intensity of the lines, the lighting can be 
optimized using the automated tuning process (Section 3.4.15). 

 

Figure E-0-4: Image Artifact Example 
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Appendix F 

1700 Wafer Reader Mount Conversion 
The 1700 reader can be mounted either horizontally or vertically depending on the 
positions of the read window and light trap (see Figure F-0-1). The 1700 can be easily 
converted from one mounting configuration to the other. In the following example, a 
horizontal mount 1700 is converted to a vertical. 

NOTE If possible, perform these steps within a cleanroom environment (Class 1000 or better) at an 
electrostatic discharge (ESD)-safe work station. Use cleanroom-approved gloves to avoid 
fingerprints on the read window. If the conversion is not done in a cleanroom, there is a possibility 
of introducing "artifacts" on the optics. Also, depending on the Class of the cleanroom where the 
reader will be used, the reader may no longer meet Class specifications after the conversion has 
been done.  

To convert the mount configuration: 

1 Using a .050 inch Allen wrench, remove the two 2-56 x 3/16" button head screws that 
attach the light trap, and the two screws that attach the read window. 

 

Figure F-0-1: Location of Light Trap and Read window (Horizontal Mount Configuration) 
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2 Remove the light trap and read window from the 1700 case. 

 

Figure F-0-2: Removing the Light Trap and Read window 

3 Place the read window, with the top of the frame (thick edge of wedge) facing down, 
in the opening that was occupied by the light trap; place the light trap, with the top 
nearest to the back of the reader, in the other opening. 

 

Figure F-0-3: Read Window and Light Trap Orientation 
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Figure F-0-4: Reattaching the Read window and Light Trap  

4 Tighten all four screws, with a maximum torque of 2 inch-lbs. 

 

Figure F-0-5: Vertical Mount Configuration (Shown Horizontally) 
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Appendix G 

Cleaning the Reader 
To maintain optimal imaging and reading performance, keep the glass read window free 
of dust and fingerprints. To remove dust, use a pressurized air duster. If the window 
needs cleaning, use a cleaner approved for use on coated optics, such as the Lens Pen 
which is included in the Starter Accessories Kit, or a lens cleaning cloth. Do not use 
alcohol-based cleaning solutions, which will damage the anti-reflective coating on the 
window. Do not spray water or cleaning fluids directly onto the glass window, which could 
allow moisture to enter the case. 
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Appendix H 

SEMI® Wafer Marking Specifications 
The In-Sight 1700 identifies wafers marked according to the following specifications: 

! SEMI M1.15-1000 � Standard For 300 mm Polished Monocrystalline Silicon 
Wafers (Notched). Combines elements of the SEMI T7 and SEMI M12 specifications 
for defining the characteristics and positioning of the rectangular 2D Data Matrix code 
symbol and the (optional) 12-character alphanumeric string marked on the back 
surface of 300 mm wafers. 

! SEMI T7-0997 � Specification For Back Surface Marking of Double-Side 
Polished Wafers With A Two-Dimensional Matrix Code. Defines the 
characteristics and positioning of the rectangular 2D Data Matrix code symbol 
marked on the back surface of 300 mm wafers. 

! SEMI M12-0998 � Specification For Serial Alphanumeric Marking of the Front 
Surface Of Wafers. Defines the characteristics and positioning of the 12-character 
alphanumeric string marked on the front surface of 100/125/150 mm (flatted) and 
150/200 mm (notched) wafers. 

! SEMI M13-0998 � Specification For Alphanumeric Marking Of Silicon Wafers. 
Defines the characteristics and positioning of the 18-character alphanumeric string 
marked on 100/125/150 mm (flatted) and 150/200 mm (notched) wafers. 

! SEMI T1-95 � Specification For Back Surface Bar Code Marking Of Silicon 
Wafers. Defines the characteristics and positioning of the barcode marked on the 
back surface of 125 mm or larger wafers. 

For copies of the complete specifications, visit the Semiconductor Equipment and 
Materials International (SEMI) organization at http://www.semi.org. 

 

http://www.semi.org/
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